
 

Cisco MetroPlanner  
DWDM Operations Guide
Software Release 7.0 
Last Updated: December 2010
Corporate Headquarters
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-1706 
USA
http://www.cisco.com
Tel: 408 526-4000

800 553-NETS (6387)
Fax: 408 526-4100

Customer Order Number: DOC-7817293=
Text Part Number: 78-17293-01

http://www.cisco.com


 

THE SPECIFICATIONS AND INFORMATION REGARDING THE PRODUCTS IN THIS MANUAL ARE SUBJECT TO CHANGE WITHOUT NOTICE. ALL 
STATEMENTS, INFORMATION, AND RECOMMENDATIONS IN THIS MANUAL ARE BELIEVED TO BE ACCURATE BUT ARE PRESENTED WITHOUT 
WARRANTY OF ANY KIND, EXPRESS OR IMPLIED. USERS MUST TAKE FULL RESPONSIBILITY FOR THEIR APPLICATION OF ANY PRODUCTS.

THE SOFTWARE LICENSE AND LIMITED WARRANTY FOR THE ACCOMPANYING PRODUCT ARE SET FORTH IN THE INFORMATION PACKET THAT 
SHIPPED WITH THE PRODUCT AND ARE INCORPORATED HEREIN BY THIS REFERENCE. IF YOU ARE UNABLE TO LOCATE THE SOFTWARE LICENSE 
OR LIMITED WARRANTY, CONTACT YOUR CISCO REPRESENTATIVE FOR A COPY.

The following information is for FCC compliance of Class A devices: This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant 
to part 15 of the FCC rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial 
environment. This equipment generates, uses, and can radiate radio-frequency energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference, in which case users will be required 
to correct the interference at their own expense. 

The following information is for FCC compliance of Class B devices: The equipment described in this manual generates and may radiate radio-frequency energy. If it is not 
installed in accordance with Cisco’s installation instructions, it may cause interference with radio and television reception. This equipment has been tested and found to 
comply with the limits for a Class B digital device in accordance with the specifications in part 15 of the FCC rules. These specifications are designed to provide reasonable 
protection against such interference in a residential installation. However, there is no guarantee that interference will not occur in a particular installation. 

Modifying the equipment without Cisco’s written authorization may result in the equipment no longer complying with FCC requirements for Class A or Class B digital 
devices. In that event, your right to use the equipment may be limited by FCC regulations, and you may be required to correct any interference to radio or television 
communications at your own expense.

You can determine whether your equipment is causing interference by turning it off. If the interference stops, it was probably caused by the Cisco equipment or one of its 
peripheral devices. If the equipment causes interference to radio or television reception, try to correct the interference by using one or more of the following measures:

• Turn the television or radio antenna until the interference stops.

• Move the equipment to one side or the other of the television or radio.

• Move the equipment farther away from the television or radio.

• Plug the equipment into an outlet that is on a different circuit from the television or radio. (That is, make certain the equipment and the television or radio are on circuits 
controlled by different circuit breakers or fuses.) 

Modifications to this product not authorized by Cisco Systems, Inc. could void the FCC approval and negate your authority to operate the product. 

The Cisco implementation of TCP header compression is an adaptation of a program developed by the University of California, Berkeley (UCB) as part of UCB’s public 
domain version of the UNIX operating system. All rights reserved. Copyright © 1981, Regents of the University of California. 

NOTWITHSTANDING ANY OTHER WARRANTY HEREIN, ALL DOCUMENT FILES AND SOFTWARE OF THESE SUPPLIERS ARE PROVIDED “AS IS” WITH 
ALL FAULTS. CISCO AND THE ABOVE-NAMED SUPPLIERS DISCLAIM ALL WARRANTIES, EXPRESSED OR IMPLIED, INCLUDING, WITHOUT 
LIMITATION, THOSE OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT OR ARISING FROM A COURSE OF 
DEALING, USAGE, OR TRADE PRACTICE.

IN NO EVENT SHALL CISCO OR ITS SUPPLIERS BE LIABLE FOR ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, INCLUDING, 
WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF CISCO 
OR ITS SUPPLIERS HAVE BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

Cisco and the Cisco Logo are trademarks of Cisco Systems, Inc. and/or its affiliates in the U.S. and other countries. A listing of Cisco's trademarks can be found at 
www.cisco.com/go/trademarks. Third party trademarks mentioned are the property of their respective owners. The use of the word partner does not imply a partnership 
relationship between Cisco and any other company. (1005R)

Cisco MetroPlanner DWDM Operations Guide, Release 7.0 
Copyright © 2011 Cisco Systems, Inc. All rights reserved.

http://www.cisco.com/go/trademarks


 

Cisco
March 2006
C O N T E N T S
About this Guide     xi

Revision History     xi

Document Objectives     xi

Audience     xi

Document Organization     xii

Related Documentation     xii

Document Conventions     xii

Obtaining Optical Networking Information     xiii

Where to Find Safety and Warning Information     xiv

Cisco Optical Networking Product Documentation CD-ROM     xiv

Obtaining Documentation and Submitting a Service Request     xiv

C H A P T E R  1 Overview     1-1

1.1  Cisco MetroPlanner Features     1-1

1.2  Network Design Process     1-2

1.2.1  Network Design Optimization     1-2

1.2.2  Network Design Constraints     1-2

1.2.3  Platform Support     1-3

1.2.4  Topology Support     1-3

1.2.5  Protection Scheme Support     1-3

1.2.6  Service Support     1-4

1.3  Cisco MetroPlanner Process Flow     1-5

1.4  Planning Traffic in Cisco MetroPlanner 7.0     1-7

1.5  Cisco MetroPlanner 7.0 Traffic     1-8

1.5.1  Point-to-Point Traffic Groups     1-8

1.5.2  P-Ring Traffic Groups     1-9

1.5.3  ROADM Traffic Groups     1-9

C H A P T E R  2 Designing Networks with Cisco MetroPlanner     2-1

2.1  Launching Cisco MetroPlanner      2-1

2.1.1  Opening a Project     2-3

2.1.2  Loading and Unloading Networks     2-3

2.1.3  Saving a Project     2-4

2.1.4  Importing a Cisco MetroPlanner 2.5 Project     2-4
iii
 MetroPlanner DWDM Operations Guide, Release 7.0



 

Contents
2.1.5  Closing a Project     2-5

2.2  Setting Cisco MetroPlanner Options     2-5

2.2.1  Setting the Graphical Display     2-5

2.2.2  Setting the Default Platform Values     2-7

2.2.3  Setting the Default Project Values     2-9

2.2.4  Setting the Fiber Type Default Values     2-9

2.2.5  Defining Third-Party DWDM Interfaces     2-10

2.2.6  Updating the Restricted Equipment List     2-15

2.2.7  Exporting a File     2-16

2.2.8  Importing a File     2-17

2.2.9  Resetting the Default Layout     2-18

2.2.10  Adding Plug-ins     2-18

2.2.11  Managing Plug-ins     2-19

2.2.12  Adding User Profiles     2-20

2.2.13  Running a Script     2-21

2.3  Creating a Project     2-21

2.3.1  Adding Sites      2-27

2.3.2  Deleting Sites     2-28

2.3.3  Adding Fiber Spans     2-28

2.3.4  Creating a Point-to-Point Demand     2-29

2.3.5  Creating a Protected Ring Demand     2-31

2.3.6  Creating a ROADM Demand     2-33

2.3.7  Deleting a Network     2-35

2.3.8  Adding Notes to a Project     2-35

2.3.9  Deleting Notes     2-35

2.4  Analyzing the Network     2-36

2.5  Viewing Network Reports     2-36

2.5.1  Viewing the Summary Report     2-37

2.5.2  Saving the NE Update File     2-39

2.5.3  Viewing the Installation Parameters     2-40

2.5.4  Viewing Internal Connections     2-42

2.5.5  Viewing the Traffic Matrix Report     2-43

2.5.6  Displaying the Layout      2-46

2.5.7  Viewing the Link Availability Report     2-49

2.5.8  Viewing Optical Results     2-51

2.5.9  Viewing Wavelength Routing     2-54

2.5.10  Viewing Report Differences     2-55

2.6  Editing a Project     2-61

2.6.1  Editing Project Parameters     2-62
iv
Cisco MetroPlanner DWDM Operations Guide, Release 7.0

March 2006



 

Contents
2.6.2  Editing Network Parameters     2-62

2.6.3  Editing Site Parameters     2-63

2.6.4  Deleting a Site     2-67

2.6.5  Creating a Maintenance Center     2-67

2.6.6  Editing a Point-to-Point Demand     2-67

2.6.7  Editing a P-Ring Demand     2-68

2.6.8  Editing a ROADM Demand     2-70

2.6.9  Deleting a Traffic Demand     2-71

2.6.10  Editing Fiber Span Parameters     2-71

2.6.11  Deleting a Fiber Span     2-73

2.6.12  Arranging Sites     2-73

2.7  Managing the Network Design     2-77

2.7.1  Creating a Copy of the Network     2-78

2.7.2  Creating a Network in the Install State     2-78

2.7.3  Creating an Upgrade Network     2-79

2.7.4  Unlocking Parameters in the Network Design     2-80

2.8  Generating a BoM     2-80

2.8.1  Viewing BoM Report Totals     2-81

2.8.2  Generating a Network BoM     2-81

2.8.3  Generating a Site BoM     2-83

2.8.4  Generating a Spare Parts Report     2-84

2.8.5  Exporting a BoM     2-86

2.9  Managing the Price List     2-86

2.9.1  Creating a New Price List     2-86

2.9.2  Viewing a Price List     2-87

2.9.3  Loading and Unloading Price Lists     2-89

2.9.4  Updating a Price List from CCO     2-89

2.9.5  Copying a Price List     2-89

2.9.6  Deleting a Price List     2-90

2.9.7  Viewing Maintenance Contracts     2-90

C H A P T E R  3 Modeled Network Examples     3-1

3.1  Supported Cisco MetroPlanner Topologies     3-1

3.2  Bus Topologies     3-1

3.2.1  Single-Span Topology     3-1

3.2.2  Point-to-Point Topology      3-2

3.2.3  Linear Topology     3-2

3.3  Hubbed Ring Topology     3-2

3.4  Meshed Topology     3-3
v
Cisco MetroPlanner DWDM Operations Guide, Release 7.0

March 2006



 

Contents
A P P E N D I X  A GUI Information and Shortcuts     A-1

A P P E N D I X  B Card Types     B-1

IN D E X
vi
Cisco MetroPlanner DWDM Operations Guide, Release 7.0

March 2006



F I G U R E S

 

Figure 1-1 Cisco MetroPlanner Process Flow     6

Figure 1-2 Project Explorer View     8

Figure 1-3 Point-to-Point Traffic Group in the Project Explorer     9

Figure 1-4 P-Ring Traffic Group in the Project Explorer     9

Figure 1-5 ROADM Traffic Group in the Project Explorer     10

Figure 2-1 Cisco MetroPlanner 7.0 Login Dialog Box     2

Figure 2-2 Opening a Project from the Tasks Pane     3

Figure 2-3 Unloaded Network in the Project Explorer     4

Figure 2-4 Loaded Network in the Project Explorer     4

Figure 2-5 Options Explorer Dialog Box     6

Figure 2-6 Duct Details Shown on the NtVw Net# Tab     7

Figure 2-7 Alien Card Dialog Box     11

Figure 2-8 Alien Software Dialog Box     12

Figure 2-9 Interface Operative Area     14

Figure 2-10 Export Dialog Box     16

Figure 2-11 Import Dialog Box     17

Figure 2-12 PlugIn Registry Dialog Box     19

Figure 2-13 Project Creation Wizard     22

Figure 2-14 Project Creation Wizard Subnet Page     23

Figure 2-15 Network Creation Wizard Topology Page     24

Figure 2-16 Network Creation Wizard Site Management Page     25

Figure 2-17 Network Creation Wizard Span Parameters Page     26

Figure 2-18 Point to Point Demand Creation Wizard     29

Figure 2-19 Point-to-Point Demand Between Two Sites     30

Figure 2-20 P-Ring Creation Wizard     31

Figure 2-21 P-Ring Demand     33

Figure 2-22 Create ROADM Demand Dialog Box     34

Figure 2-23 Summary Tab     38

Figure 2-24 ANS View Subtab in the Installation Parameters Tab     40

Figure 2-25 Internal Connections Tab     42

Figure 2-26 Query Dialog     44
vii
Cisco MetroPlanner DWDM Operations Guide, Release 7.0

March 2006



 

Figures
Figure 2-27 Traffic Matrix Tab     45

Figure 2-28 Layout Report (Rack View)     47

Figure 2-29 Layout Report (Shelf View)     48

Figure 2-30 Link Availability Report     50

Figure 2-31 Optical Results Tab     52

Figure 2-32 Wavelength Routing Tab     54

Figure 2-33 Reports Diff Dialog Box     56

Figure 2-34 BOM Diff Report     57

Figure 2-35 Installation Parameters Diff Report     59

Figure 2-36 Internal Connections Diff Report     60

Figure 2-37 Site in the Project Explorer     63

Figure 2-38 Edit Point to Point Demand Dialog Box     68

Figure 2-39 Edit P-Ring Demand Dialog Box     69

Figure 2-40 Edit ROADM Demand Dialog Box     70

Figure 2-41 Ellipse Shape     74

Figure 2-42 Square Shape     75

Figure 2-43 Snake Shape     76

Figure 2-44 Double Ring Shape     77

Figure 2-45 Locked Sites in the Project Explorer View     80

Figure 2-46 Bill of Material Tab, Net View Subtab     82

Figure 2-47 Bill of Material Tab, Site View Subtab     83

Figure 2-48 Bill of Material Tab, Spare Subtab     85

Figure 2-49 Price Manager Dialog Box     87

Figure 3-1 Single-Span Topology Example     2

Figure 3-2 Point-to-Point Topology Example     2

Figure 3-3 Linear Topology Example     2

Figure 3-4 Hubbed Ring Topology Example     3

Figure 3-5 Meshed Ring Topology Example     4

Figure A-1 Cisco MetroPlanner Window with Network Tree     1
viii
Cisco MetroPlanner DWDM Operations Guide, Release 7.0

March 2006



T A B L E S

 

Table 2-1 Supported Combination for 40-Gbs Third-Party Interface     14

Table 2-2 Supported Combinations for 10-Gbs Third-Party Interface     15

Table 2-3 Supported Combinations for 2.5-Gbs Third-Party Interface     15

Table 2-4 Different Privileges for Network Designer and Base Network Designer     20

Table 2-5 Valid Ranges for Fiber Factor Values     27

Table 2-6 Notes Window     35

Table 2-7 Report Availability     36

Table 2-8 Summary Tab Categories     38

Table 2-9 Installation Parameters Report ANS View Tab Columns     40

Table 2-10 Installation Parameters Report ANP View Tab     41

Table 2-11 Installation Parameters Report PP View Tab     41

Table 2-12 Internal Connections Tab Columns     43

Table 2-13 Query Dialog Fields     44

Table 2-14 Traffic Matrix Tab Columns     45

Table 2-15 Query Dialog Fields     49

Table 2-16 Link Availability Tab Columns     50

Table 2-17 Query Dialog Fields     51

Table 2-18 Optical Results Tab Columns     52

Table 2-19 Wavelength Routing Tab Columns     55

Table 2-20 BoM Diff Report Columns     58

Table 2-21 Installation Parameters Diff Report Columns     59

Table 2-22 Internal Connections Tab Columns     61

Table 2-23 Site Design Rules     65

Table 2-24 Editable Fiber Properties     71

Table 2-25 BoM Net View Columns     82

Table 2-26 BoM Site View Columns     83

Table 2-27 BoM Spare Subtab Columns     85

Table A-1 Menu and Toolbar Options     2

Table A-2 Project Explorer Toolbar Options     5

Table A-3 Properties Pane Toolbar Options     6

Table A-4 Analyzer Toolbar Options     7
ix
Cisco MetroPlanner DWDM Operations Guide, Release 7.0

March 2006



 

Tables
Table A-5 Tasks Pane Toolbar Options     7

Table A-6 Shortcut Menu Actions     9

Table A-7 Site Icons     11

Table B-1 OC-192/STM-64 (9.953 Gbps)     1

Table B-2 OC-48/STM-16  (2.488 Gbps)     2

Table B-3 OC-12/STM-4  (622 Mbps)     2

Table B-4 OC-3/STM-1  (155 Mbps)     3

Table B-5 10GE WAN PHY (9.953 Gbps)     3

Table B-6 10GE LAN PHY (10.3 Gbps)     3

Table B-7 GE (1.25Gbps)     4

Table B-8 Fast Ethernet (100 Mbps)     5

Table B-9 FC-10G (10.5 Gbps)     5

Table B-10 FC-4G (4.25 Gbps)     5

Table B-11 FC-2G (2.125 Gbps)     6

Table B-12 FC-1G (1.062 Gbps)     6

Table B-13 FICON-2G (2.125 Gbps)     7

Table B-14 FICON-1G (1.062 Gbps)     7

Table B-15 ESCON (200 Mbps)     8

Table B-16 ISC-Compat (1.062 Gbps)     8

Table B-17 ISC-Peer 2R     8

Table B-18 ISC-3 Peer-1G  (1.062 Gbps)     8

Table B-19 ISC-3 Peer-2G (2.125 Gbps)     9

Table B-20 Sysplex ETR  (8 Mbps)     9

Table B-21 Sysplex CLO  (8 Mbps)     9

Table B-22 SDI     9

Table B-23 DVB-ASI     9

Table B-24 D1-Video  (270 Mbps)     10

Table B-25 HDTV  (1.48 Gbps)     10

Table B-26 DV-6000  (2.38 Gbps)     10

Table B-27 2R Any Rate     10

Table B-28 ONS 15530 2.5G ITU-T     10

Table B-29 ONS 15530 10G ITU-T     11
x
Cisco MetroPlanner DWDM Operations Guide, Release 7.0

March 2006



 

About this Guide

This section explains the objectives, intended audience, and organization of this publication and 
describes the conventions that convey instructions and other information. 

This section provides the following information:

 • Revision History

 • Document Objectives

 • Audience

 • Document Organization

 • Related Documentation

 • Document Conventions

 • Obtaining Optical Networking Information

 • Obtaining Documentation and Submitting a Service Request

Revision History

Document Objectives
This user guide explains how to design networks using the Cisco MetroPlanner design tool for the 
Cisco ONS 15454 system. It contains information about how to design an optical network. Use this user 
guide in conjunction with the appropriate publications listed in the Related Documentation section.

Audience
This publication is intended for experienced network system engineers who are responsible for planning 
and ordering equipment for Cisco optical networking systems.

Date Notes

December 2010 Updated the “Editing Site Parameters” section in the “Designing Networks with 
Cisco MetroPlanner” chapter.
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About this Guide
Document Organization
This Cisco MetroPlanner DWDM Operations Guide, Release 7.0 is organized into the following 
chapters:

 • Chapter 1, “Overview” provides a list of features, an overview of the network design process, a 
description of the internal architecture, and the Cisco MetroPlanner procedural flow.

 • Chapter 2, “Designing Networks with Cisco MetroPlanner” provides instructions for using the 
Cisco MetroPlanner tool to create a network design, adjust and optimize design components, and 
generate reports and bills of materials.

 • Chapter 3, “Modeled Network Examples” provides examples of typical optical networks that you 
can model using Cisco MetroPlanner.

 • Appendix A, “GUI Information and Shortcuts” provides Cisco MetroPlanner graphical user 
interface shortcuts. 

 • Appendix B, “Card Types” provides a list of card types that can be used to build a network, and the 
corresponding Cisco product identifier.

 • Appendix C, “Troubleshooting” describes problems you may encounter using Cisco MetroPlanner, 
and their possible solutions.

Related Documentation
Use this Cisco MetroPlanner DWDM Operations Guide, Release 7.0 with the following referenced 
publications:

 • Cisco ONS 15454 DWDM Procedure Guide, R7.0—Provides procedures to install, turn up, 
provision, and maintain a Cisco ONS 15454 node and network.

 • Cisco ONS 15454 DWDM Reference Manual, R7.0—Provides reference material for Cisco 
ONS 15454 nodes and networks.

 • Cisco ONS 15454 DWDM Troubleshooting Guide, R7.0—Provides general troubleshooting 
procedures, and alarm descriptions.

 • Cisco SONET TL1 Command Guide, R7.0 and Cisco SDH TL1 Command Guide, R7.0—Provides test 
access TL1 commands, configurations, and parameter types.

 • Release Notes for the Cisco ONS 15454, R7.0 and Release Notes for the Cisco ONS 15454 SDH, 
R7.0—Provides caveats, closed issues, and new feature and functionality information.

Document Conventions
This publication uses the following conventions:

Convention Application

boldface Commands and keywords in body text.

italic Command input that is supplied by the user.
xii
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About this Guide
Note Means reader take note. Notes contain helpful suggestions or references to material not covered in the 
document.

Caution Means reader be careful. In this situation, the user might do something that could result in equipment 
damage or loss of data.

Obtaining Optical Networking Information
This section contains information that is specific to optical networking products. For information that 
pertains to all of Cisco, refer to the Obtaining Documentation and Submitting a Service Request section.

[     ] Keywords or arguments that appear within square brackets are optional.

{ x | x | x } A choice of keywords (represented by x) appears in braces separated by 
vertical bars. The user must select one.

Ctrl The control key. For example, where Ctrl + D is written, hold down the 
Control key while pressing the D key.

screen font Examples of information displayed on the screen.

boldface screen font Examples of information that the user must enter.

<     > Command parameters that must be replaced by module-specific codes.

Warning IMPORTANT SAFETY INSTRUCTIONS

This warning symbol means danger. You are in a situation that could cause bodily injury. Before you 
work on any equipment, be aware of the hazards involved with electrical circuitry and be familiar 
with standard practices for preventing accidents. To see translations of the warnings that appear in 
this publication, refer to the translated safety warnings that accompanied this device.

Note:  SAVE THESE INSTRUCTIONS

Note:  This documentation is to be used in conjunction with the specific product installation guide 
that shipped with the product. Please refer to the Installation Guide, Configuration Guide, or other 
enclosed additional documentation for further details.

Convention Application
xiii
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About this Guide
Where to Find Safety and Warning Information
For safety and warning information, refer to the Cisco Optical Transport Products Safety and 
Compliance Information document that accompanied the product. This publication describes the 
international agency compliance and safety information for the Cisco ONS 15454 system. It also 
includes translations of the safety warnings that appear in the ONS 15454 system documentation.

Cisco Optical Networking Product Documentation CD-ROM
Optical networking-related documentation, including Cisco ONS 15xxx product documentation, is 
available in a CD-ROM package that ships with your product. The Optical Networking Product 
Documentation CD-ROM is updated periodically and may be more current than printed documentation.

Obtaining Documentation and Submitting a Service Request
For information on obtaining documentation, submitting a service request, and gathering additional 
information, see the monthly What’s New in Cisco Product Documentation, which also lists all new and 
revised Cisco technical documentation, at:

http://www.cisco.com/en/US/docs/general/whatsnew/whatsnew.html

Subscribe to the What’s New in Cisco Product Documentation as a Really Simple Syndication (RSS) feed 
and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free 
service and Cisco currently supports RSS Version 2.0.
xiv
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C H A P T E R 1

Overview

Cisco MetroPlanner Release 7.0 provides a way to model and test wavelength division multiplexing 
(WDM) optical networks in a graphical environment. The primary purpose of Cisco MetroPlanner is to 
help sales engineers (SEs) design and validate networks of Cisco Optical Networking System (ONS) 
15454 Multi-Service Transport Platforms (MSTP). Using Cisco MetroPlanner Release 7.0, an SE can 
create multiple instances of a network to modify different parameters in each instance for comparison. 
Cisco MetroPlanner generates a shelf view of all the sites deployed in the optical network and provides 
a complete bill of materials (BOM) for the network and the differences between instances of a network. 

This chapter describes how you use Cisco MetroPlanner to design, analyze, and optimize new or existing 
Cisco optical networks and contains the following sections:

 • 1.1  Cisco MetroPlanner Features, page 1-1

 • 1.2  Network Design Process, page 1-2

 • 1.3  Cisco MetroPlanner Process Flow, page 1-5

 • 1.4  Planning Traffic in Cisco MetroPlanner 7.0, page 1-7

 • 1.5  Cisco MetroPlanner 7.0 Traffic, page 1-8

1.1  Cisco MetroPlanner Features
Cisco MetroPlanner Release 7.0 provides a simple tool set for designing optical networks with Cisco 
ONS 15454 MSTP products. You can enter all of the network parameters or minimal information, such 
as site distance, and Cisco MetroPlanner will model the network you need to build and generate a 
detailed BOM with ordering information. Designing optical networks requires the verification of 
multiple constraints such as optical budget limitations and platform architectural restrictions. One 
Cisco MetroPlanner project can contain multiple copies of a network. This allows you to change 
parameters in one network copy, then analyze and compare to another network copy to determine the 
differences. In addition to this capability, Cisco MetroPlanner Release 7.0 provides the following new 
features: 

 • Network upgrade to implement forecasted channels

 • Slot preprovisioning (by importing the NE Update file into the Cisco Transport Controller [CTC]))

 • User-defined equipment lists in the parts database

 • Fiber separation allowing a user to manage certain parameters (such as loss) for each strand in a fiber 
pair 

 • Forced equipment settings (user-defined parameters instead of Cisco MetroPlanner automatic 
settings)
1-1
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1.2  Network Design Process
 • Power consumption calculation

 • L-band design 

 • C-band enhanced booster 

 • C-band + L-band/50-GHz scalable design

 • Multishelf management 

 • New DWDM client interfaces

 • Meshed reconfigurable optical add/drop multiplexing (ROADM) 

 • Capability to select the type of maintenance contract desired to appear in the BOM

1.2  Network Design Process
To generate a network design, the SE enters the following parameters:

 • The number of network sites

 • The type of equipment used at each site

 • The distance separating the sites

 • The type of fiber connecting the sites

 • Service demands, including the service type, the protection type, and the number of channels 
between nodes

When the network parameters are entered, Cisco MetroPlanner finds the best routing, defines the 
required add/drop filters, and places optical amplifiers and dispersion compensation units (DCUs) to fit 
the user traffic demands at the minimum cost. Optimization is performed to meet the boundary 
conditions. The optimization includes attenuation and amplification.

Finally, Cisco MetroPlanner generates a BOM, which includes the product codes, the quantities, and 
pricing information. In addition, it creates other reports, such as a shelf-level view of the configuration, 
which can be printed. This helps the SE understand how the shelf is built and helps to avoid confusion 
and errors during the actual deployment. Within the BOM is the total network cost, which allows a quick 
comparison of various design options. The total network cost is the cost of the equipment for all of the 
sites in the designed network.

1.2.1  Network Design Optimization
Cisco MetroPlanner searches for the best solution to a designed network using an optimization 
algorithm. 

1.2.2  Network Design Constraints
A network design must meet the optical budget and receiver overload criteria to operate efficiently. An 
analysis of optical budget and receiver overload evaluates the strength of the signal traversing the ring. 
If a design solution satisfies the constraints, it is a valid design. The Cisco MetroPlanner Release 7.0 
optimization algorithms generate multiple solutions and verify the constraints against those solutions. If 
the constraints are satisfied, the solution with the lowest cost-to-utilization ratio is selected as the 
optimal solution.
1-2
Cisco MetroPlanner DWDM Operations Guide, Release 7.0

March 2006



 

Chapter 1      Overview
1.2.3  Platform Support
If the network design solution fails to satisfy all the constraints, Cisco MetroPlanner Release 7.0 makes 
adjustments to parameters such as signal attenuation and amplification. Amplification is achieved by 
using an erbium-doped fiber amplifier (EDFA). Attenuation is achieved by using variable optical 
attenuator (VOA) modules integrated into the platform. Cisco MetroPlanner Release 7.0 corrects the 
optical budget using an algorithm that includes automatic placement of EDFAs and VOA regulation.

For each internodal demand, Cisco MetroPlanner Release 7.0 performs an optical budget and receiver 
overload analysis and displays the results in various reports in the GUI. If the network design algorithms 
are not able to provide a solution, then you can modify the input data (for example, by relaxing some 
user constraints) and run the analysis again. 

1.2.3  Platform Support
Cisco MetroPlanner Release 7.0 supports the Cisco ONS 15454 DWDM optical platform Software 
Releases 4.7, 5.0, and 7.0.

1.2.4  Topology Support
Cisco MetroPlanner 7.0 supports the following network topologies:

 • Bus (single span, point-to-point, and linear)

 • Open (or hubbed) ring

 • Closed (or meshed) ring

 • Any-to-any ring (ROADM)

Cisco MetroPlanner 7.0 allows you to design flexible networks with up to 60 site locations. A flexible 
network is a network that, using ROADM nodes, allows traffic modification/reconfiguration as traffic 
requirements change. The main feature of flexible networks is the traffic reconfiguration/modification 
among all the networked nodes or among a subset of them. 

The maximum number of locations where the optical service channel (OSC) is terminated is 20. The 
maximum number of add/drop locations is 16.

1.2.5  Protection Scheme Support
Cisco MetroPlanner 7.0 designs support the following protection schemes:

 • Y-cable protected—In Y-cable protection, one transponder card is designated as active and the other 
as standby. The standby transponder card has the client-side laser turned off to avoid corrupting the 
signal transmitted back to the client. The active transponder monitors the signal from the trunk side 
and in the event of loss or signal failure, the system switches to the standby path.

 • Client-based 1+1—Two client signals are transmitted to separated line cards or transponder cards 
instead of using a Y-cable to split one client signal into two line cards or transponder cards. In client 
1+1 protection, the failure and switchover is controlled by the client system.

 • Fiber-switched protection—The single client signal is injected into the client receive (Rx) port. It is 
then split into two separate signals on the two trunk transmit (Tx) ports. The two signals are 
transmitted over diverse paths. The far-end card chooses one of the two trunk Rx port signals and 
injects it into the Tx client port.

 • Unprotected—Protection is not used.
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1.2.6  Service Support
Cisco MetroPlanner 7.0 can support any subset of the following services:

 • Alien (third-party client interface)

 • Cisco ONS 15530 7.0 Gbps Aggregated

 • ONS 15530 10 Gbps Aggregated

 • ONS 15530 Multirate (MR) Transport

 • ONS 15530 Data Multiplexor (MXP)

 • 2R Any Rate

 • Gigabit Ethernet

 • 10GE—10 Gigabit Ethernet (LAN and WAN)

 • D1 Video

 • DVB-ASI—Digital Video Broadcast-Asynchronous Serial Interface.

 • DV-6000

 • ESCON—Enterprise System Connection 

 • Fast Ethernet

 • Fibre Channel 1G

 • Fibre Channel 2G

 • Fibre Channel 4G

 • Fibre Channel 10G

 • FICON—Fiber Connection 1G

 • FICON Express 2G

 • High Definition Television (HDTV)

 • ISC-3 Peer (1G)

 • ISC-3 Peer (2G)

 • ISC-3 Peer (2R)

 • ISC-Compat (ISC-3 Compatibility Mode)

 • OC-3

 • OC-12

 • OC-48

 • OC-192

 • OC-768

 • SDI—Serial Data Input 

 • STM-1

 • STM-4

 • STM-16

 • STM-64

 • STM-256
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 • Sysplex CLO—Control Link Oscillator 

 • Sysplex ETR—External Throughput Rate 

Note The Sysplex CLO and Sysplex ETR services are supported only on the following topologies: 

 • Single span—Two terminal sites with 32MUX-O and 32DMX-O cards, or 32WSS and 32DMX or 
32DMX-O cards installed and no intermediate sites in between.

 • Point-to-Point—Two terminal sites with 32MUX-O and 32DMX-O cards. or 32WSS and 32DMX 
or 32DMX-O cards installed. Line amplifiers can be installed between the terminal sites, but 
intermediate (traffic terminating) sites cannot be installed.

 • Two hubs—Two hub nodes in a ring with 32MUX-O, 32DMX-O, 32WSS, and 32DMX cards or 
32DMX-O cards installed. Line amplifiers can be installed between the hubs.

Refer to the Cisco ONS 15454 DWDM Reference Manual for more information about the supported 
topologies for the ETR and CLO services.

1.3  Cisco MetroPlanner Process Flow
The following stages are used to complete a network design. See Figure 1-1 for the process flow.

1. Create a project using the Project Creation wizard.

2. Create a network using the Create Network wizard. The Create Network wizards adds sites and 
places the fiber spans between the sites. A span represents a pair of fibers. 

3. Create a point-to-point, protected ring (P-ring), and/or ROADM service demand.

4. Analyze the network design.

5. If you would like to force automatic tool choices, adjust the design and repeat the analysis until you 
have reached the desired configuration.

6. Create an Install copy of the network and update the parameters with real data from the field.

7. Analyze the Install network.

8. Create an upgrade copy of the network, as needed, to add forecasted channels.
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Figure 1-1 Cisco MetroPlanner Process Flow
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1.4  Planning Traffic in Cisco MetroPlanner 7.0
Traffic in Cisco MetroPlanner is defined as an optical path for each pair of nodes requiring a service 
demand. An optical path is the combined channels between the two nodes. The following list gives 
definitions for some basic traffic items:

 • Circuit—A single channel between a pair of source and destination nodes. Depending on the traffic 
demand type, the number of circuits can vary from 0 to 32 between a pair of nodes. In addition to 
the source and destination nodes and all the attributes that are common to the service containing the 
circuit, a circuit has the following attributes:

 – Present/forecast indication

 – Routing direction for unprotected service

 – ITU channel

 – Optical bypass indication

 • Demand—A set of circuits with common characteristics, such as:

 – Service demand label

 – Number of existing circuits

 – Number of forecasted circuits

 – Client service type

 – Protection type

 – Optical bypass (number of channels and/or sites)

 – WDM interface type (TXT or ITU-LC)

 – WDM card type

 – Source client interface (SR, IR, or LR) 

 – Destination client interface (SR, IR, or LR)

 • Traffic group—All demands between the same set of nodes. Both L-band and C-band are supported. 
The following traffic groups are supported:

 – P-ring—All the demands used to support traffic topologies similar to bidirectional line switch 
rings (BLSRs) or multiplex section-shared protection rings (MS-SPRings). Each P-ring demand 
is between a pair of added/dropped nodes where BLSR-like (or MS-SPRing-like) traffic must 
exist. The number of circuits is the same for each demand, and is user-specified (from 1 to 32).

 – Fixed (point-to-point)—The set of nodes is restricted to two sites. The number of circuits is 
user-specified (from 1 to 32).

 – Any-to-any (ROADM)—A minimum of two nodes and a maximum of every node in the 
network. An any-to-any traffic demand allows each node to establish one or more circuits with 
the other nodes, either as a hub or meshed configuration. In a meshed configuration, each node 
defined in the set is connected to each other node. This is the most common traffic type. In a 
hub configuration, the user-defined hub node is connected to each of the other nodes.

ROADM circuits have the same protection types and services. The number of circuits is not 
user-specified and can vary from 0 to 32. For ROADM, only L-band is supported.
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1.5  Cisco MetroPlanner 7.0 Traffic
Cisco MetroPlanner 7.0 represents all of the user-defined traffic services as a tree view within the Project 
Explorer pane. The Project Explorer shows all of the open project information, including the networks, 
the network dependencies, sites, fibers, services, etc. (Figure 1-2). 

Figure 1-2 Project Explorer View

After you analyze a network design, the colors of tree view change according to the error/warning 
condition of the network design. The icons display as red if there are errors in the network design; orange 
if there are warnings but no errors; and green of there are no warnings or errors. The icon shows the color 
of the most severe condition. For more information about analyzing the network, see the “2.4  Analyzing 
the Network” section on page 2-36. 

Right-clicking on certain items in the Project Explorer tree allows you to edit the parameters. Refer to 
Chapter 2, “Designing Networks with Cisco MetroPlanner” for more information about optical results, 
the traffic matrix, and editing.

1.5.1  Point-to-Point Traffic Groups
Point-to-point traffic groups appear in the Groups > PointToPoint folders in the Project Explorer pane. 
Each point-to-point traffic group is categorized by its source and destination site names. All of the 
point-to-point services between the two sites appear under the designated demand name (Figure 1-3).
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Figure 1-3 Point-to-Point Traffic Group in the Project Explorer 

A point-to-point traffic demand includes the following information:

 • Client service type

 • Site# – Site# (source and destination site labels for this demand)

 • The number of present (P) and forecast (F) channels. The P represents circuits present since the first 
day and the F represents circuits defined in the forecast.

1.5.2  P-Ring Traffic Groups
Each protected ring (P-ring) traffic group appears in the Project Explorer pane under the Groups > 
P-Rings folders. Figure 1-4 shows an example of a P-ring traffic group in the Project Explorer.

Figure 1-4 P-Ring Traffic Group in the Project Explorer 

All the P-ring channels between each site pair are listed under each P-ring traffic group. Each demand 
is labeled with the following information:

 • P-ring number

 • Client service type

 • Site# – Site# (source and destination site labels for this demand)

 • The number of present (P) and forecast (F) channels (an entry appears for each present and forecast 
channel)

1.5.3  ROADM Traffic Groups
Each ROADM traffic group appears in the Project Explorer under the Groups > ROADMs folders. The 
ROADM traffic group folder contains one folder for each defined ROADM demand. You can define more 
demands for the same ROADM group for the same set of nodes. Figure 1-5 shows an example of a 
ROADM traffic group.
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Figure 1-5 ROADM Traffic Group in the Project Explorer 

In the Project Explorer, each ROADM demand includes the ROADM demand name and a list of DWDM 
card types that support the client service types. Protection types appear in parentheses. 

A ROADM demand can have multiple client service types and supports multiple DWDM card interfaces 
for each client service type. A ROADM demand supports the following routing strategies:

 • Protected (Default)—Each node pair in the traffic group is connected using two connections.

 • Unprotected optimum optical path—Each node pair is connected using one connection. The 
unprotected optimum optical path minimizes the number of required optical amplifiers, but also 
restricts the number of channels that can be deployed among the nodes of the traffic group 
(maximum of 32 channels between each node pair) in the installed network.

 • Unprotected minimum hop count—Each node pair in the traffic group is connected by one 
connection. The unprotected minimum hop count maximizes the number of channels (for 
unprotected traffic types only) that can be deployed among the nodes of the traffic group, but can 
requires a higher number of optical amplifiers on the unprotected optimum optical path (maximum 
of 32 channels between each node pair) in the installed network.

 • Unprotected subnet—Each node pair in the traffic group is connected using one connection. You can 
manually force connections on only one branch of the ring. For unprotected subnets, you must 
manually select one starting node of the branch and the direction the ring must be traversed to define 
the subnet, starting from the initial site. The branch direction is specified by defining the outgoing 
side first, referred to as the starting node. This routing strategy option allows you to exclude some 
critical paths and (with ROADM traffic groups containing two sites) to force each ROADM 
connection clockwise or counterclockwise.
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C H A P T E R 2

Designing Networks with Cisco MetroPlanner

Cisco MetroPlanner provides you with numerous tools for customizing the software, creating and 
analyzing networks, and creating a bill of materials (BoM). You can use Cisco MetroPlanner to perform 
the following tasks:

 • 2.1  Launching Cisco MetroPlanner, page 2-1

 • 2.2  Setting Cisco MetroPlanner Options, page 2-5

 • 2.3  Creating a Project, page 2-21

 • 2.4  Analyzing the Network, page 2-36

 • 2.5  Viewing Network Reports, page 2-36

 • 2.6  Editing a Project, page 2-61

 • 2.7  Managing the Network Design, page 2-77

 • 2.8  Generating a BoM, page 2-80

 • 2.9  Managing the Price List, page 2-86

Note To run Cisco MetroPlanner, you must install the Java 2 Platform, Standard Edition (J2SE), v 1.4.2_04 
Java Runtime Environment (JRE). You can download it from the following URL: 
 
http://java.sun.com/j2se/1.4.2/download.html

2.1  Launching Cisco MetroPlanner 
Use the following procedure to launch Cisco MetroPlanner Release 7.0:

Note Before logging in the first time to Cisco MetroPlanner R7.0, all registered users must get a new 
password. 

Step 1 Launch Cisco MetroPlanner by double-clicking the Cisco MetroPlanner R7.0 icon. The 
Cisco MetroPlanner 7.0 Login dialog box appears (Figure 2-1).
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2.1  Launching Cisco MetroPlanner
Figure 2-1 Cisco MetroPlanner 7.0 Login Dialog Box

Step 2 Enter your user name in the Login field.

Step 3 Enter your password in the Password field. 

Cisco MetroPlanner provides three chances for you to enter the correct password. The first two times 
you enter an incorrect password, Cisco MetroPlanner displays an “Incorrect Password or Login. Please 
try again” error message. After a third failed attempt, Cisco MetroPlanner exits with the error message: 
“Failed to provide correct password or login, exiting application.” 

Step 4 Check Remember login and password if you want Cisco MetroPlanner to save your user login name 
and password. 

Step 5 From the Choose a profile type drop-down list, choose one of the following profiles:

 • Network Designer

 • Base Network Designer

For more information on profiles and the capabilities they offer, see Table 2-4 on page 2-20.

Step 6 Click OK to open Cisco MetroPlanner. The login profile type appears in the lower right corner of the 
Cisco MetroPlanner window. 
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2.1.1  Opening a Project
Use the following procedure to open an existing Cisco MetroPlanner project. To create a new project, 
see the “2.3  Creating a Project” section on page 2-21.

Step 1 Click the project name under Open in the Tasks Pane (Figure 2-2). The project opens. If you do not see 
the project name listed, continue with Step 2.

Step 2 Click Open under Project in the Tasks Pane or in the File menu.

Figure 2-2 Opening a Project from the Tasks Pane

Step 3 In the Open Project dialog box, navigate to the desired directory and choose the project. Click Open. 
The Cisco MetroPlanner project appears.

2.1.2  Loading and Unloading Networks
Each network in a project requires memory. To save memory, when Cisco MetroPlanner opens a project, 
all networks are in the Unloaded state. An unloaded network appears in the Project Explorer with a “U” 
next to the network identifier (Figure 2-3). To load an unloaded network, double-click on the network 
folder in the Project Explorer, or right-click the network and choose Load from the shortcut menu. 
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Figure 2-3 Unloaded Network in the Project Explorer 

A loaded network appears in the Project Explorer with an “L” next to the network identifier (Figure 2-4). 
To unload a loaded network, right-click the network icon in the Project Explorer and choose Unload 
from the shortcut menu.

Figure 2-4 Loaded Network in the Project Explorer 

2.1.3  Saving a Project
Use the following procedure to save a project:

Step 1 Choose one of the following:

 • To save an existing project with the same filename, choose File > Save. You have completed this 
procedure.

 • To save a new project, choose File > Save and go to Step 2. 

 • To save an existing project with a different filename, choose File > Save As and go to Step 2.

Step 2 In the Save Project dialog box, navigate to the desired directory and type the filename. Click Save. 
Cisco MetroPlanner saves projects as zipped files with the extension “.zip.” 

2.1.4  Importing a Cisco MetroPlanner 2.5 Project
Use the following procedure to import a Cisco MetroPlanner 2.5 project:

Step 1 From the File menu, choose Import 2.5.x project. 

Step 2 In the Open Project dialog box, navigate to the desired directory and choose the project. 
Cisco MetroPlanner 2.5 projects have a file extension of CMZ. 
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Step 3 Click Open. The Cisco MetroPlanner 2.5 project appears.

2.1.5  Closing a Project
Use the following procedure to close a Cisco MetroPlanner project:

Step 1 From the File menu, choose Close. 

Step 2 In the Save Project dialog box, click Yes to save or No to close without saving changes. 

Step 3 If you clicked Yes and have not previously save the project, the Save Project dialog box appear. Type the 
name of the projec and click Save. The project closes. 

Step 4 To exit Cisco MetroPlanner, choose Exit from the File menu.

2.2  Setting Cisco MetroPlanner Options
Cisco MetroPlanner provides numerous options for customizing the tool and the design.

2.2.1  Setting the Graphical Display
Use the following procedure to set the Cisco MetroPlanner graphical display:

Step 1 From the Tools menu, choose Options. 

Step 2 In the Options Explorer dialog box (Figure 2-5), right-click the Graphic folder and choose Expand from 
the shortcut menu.
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Figure 2-5 Options Explorer Dialog Box 

Step 3 To change the color scheme for Cisco MetroPlanner, click Look & Feel and choose the desired scheme 
from the drop-down list. 

Step 4 To change the appearance of the Project Explorer tree, click Project Explorer and complete the 
following as needed:

 • Alarm Mode—Choose Single for an alarm icon to report only the condition of that item or 
Cumulated for an alarm icon to summarize the most critical alarm of the item and its children. 

 • Bottom Right Icon—(Display only) Displays Locking to indicate that the lock icon appears at the 
bottom right of each locked item in the Project Explorer. 

 • Top Right Icon—(Display only) Displays Alarm to indicate that the alarm icon appears at the top 
right of each alarmed item in the Project Explorer. The alarm icon will be green, yellow, orange, or 
red to indicate the alarm severity.

Step 5 To change the NtVw Net# tab appearance, click Network View and complete the following as needed:

 • In the Site area, complete the following:

 – Color, Selection Color, and Highlight Color—To change the site colors, click in the Color, 
Selection Color, and/or Highlight Color fields in the Site list. Click on the drop-down arrow to 
display a color swatch popup window. Click the desired color.

 – Show Name—Check to display the site name on the NtVw Net# tab.

 – Show Amplifiers—Check to display the amplifier icon for a site on the NtVw Net# tab.

 – Show Forced Amplifiers—Check to display the forced amplifier icon for a site on the 
NetVw Net# tab.
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 • In the Fibre area, complete the following, as needed. Figure 2-6 shows an example of a duct with all 
of the following details shown.

 – Color and Selection Color—To change the fiber color, click in the Color and/or Selection Color 
fields in the Fibre list and then click on the drop-down arrow. 

 – Show Spans—Check to display fiber spans on the NtVw Net# tab.

 – Show Length—Check to display fiber length on the NtVw Net# tab.

 – Show total SOL Loss—Check to display start of life (SOL) loss on the NtVw Net# tab.

 – Show total EOL Loss—Check to display end of life (EOL) loss on the NtVw Net# tab.

 – Show CD C-band—Check to display C-band chromatic dispersion (CD) on the NtVw Net# tab.

 – Show CD L-band—Check to display L-band chromatic dispersion (CD) on the NtVw Net# tab.

 • To change the color of the traffic demands on the NtVw Net# tab, in the Point To Point, P-Ring, and 
Any To Any areas click in the Color and Selection Color fields, and then click on the drop-down 
arrow to display a color swatch popup window. Click the desired color.

Figure 2-6 Duct Details Shown on the NtVw Net# Tab

Step 6 To change the Network Mgmt Tree tab appearance, complete the following as needed:

 • In the Network area, click in the Color and Selection fields. Click on the drop-down arrow to display 
a color swatch popup window. Click on the desired color.

 • In the Link area, complete the following:

 – To change the link color, click in the Color field in the Link list and then click on the drop-down 
arrow. Choose the desired line width from the drop-down list.

 – To change the link appearance, click in the Stroke field in the Link list and then click on the 
drop-down arrow. Choose the desired line appearance from the drop-down list.

Step 7 Click Ok.

2.2.2  Setting the Default Platform Values
Use the following procedure to establish the default traffic mapping, dense wavelength division 
multiplexing (DWDM) design, and default layout settings for a particular platform and system release. 
The default settings will appear during project creation.

Step 1 From the Tools menu, choose Options. 

Step 2 In the Options Explorer dialog box (Figure 2-5 on page 2-6), right-click Platform and choose Expand 
from the shortcut menu.

Step 3 Click the desired System Release folder and complete the following as needed:

 • Topology—(Display only) Displays Ring as the default topology. 

 • Band—Choose C-Band or L-Band as the default band.
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 • Scalable C/L—(System Release 7.0 only) Check to set scalable C bands and L bands as the default 
setting during project creation. If checked, the design will be scalable to support both C-band and 
L-band on the same system. 

 • Scalable C/50GHz—(System Release 7.0 only) Check to set scalable C-band 50 GHz as the default 
setting during project creation. If checked, the design will be scalable to support 50-Ghz channel 
spacing in C-band.

Step 4 Click the Traffic Mapping folder and complete the following as needed:

 • In the General area, choose the desired default setting from the C-Band Rules and/or L-Band Rules 
drop-down lists. Choose the option that will be the maximum per-channel power and channel 
spacing for the network design. 

 • In the Fixed traffic area, choose the default routing strategy from the drop-down list: 

 – Auto

 – Unprotected optimum optical path—Each node pair is connected using one connection. The 
unprotected optimum optical path minimizes the number of required optical amplifiers, but also 
restricts the number of channels that can be deployed among the nodes of the traffic group 
(maximum of 32 channels between each node pair) in the installed network.

 – Unprotected minimum hop count—Each node pair in the traffic group is connected by one 
connection. The unprotected minimum hop count maximizes the number of channels (for 
unprotected traffic types only) that can be deployed among the nodes of the traffic group, but 
can requires a higher number of optical amplifiers on the unprotected optimum optical path 
(maximum of 32 channels between each node pair) in the installed network.

Step 5 Click the DWDM Design Rules folder and complete the following as needed:

 • No In-line Bulk Attenuator Design—Check to design the network without using any inline bulk 
attenuators. In case the network cannot be designed without using external in-line attenuators, 
Cisco MetroPlanner displays the following error message: “Unfeasible Network design. Site X 
should require usage of in-line attenuator. Leave unchecked to allow inline bulk attentuators.”

 • No TXT/Line-Card Bulk Attenuator Design—Check to design the network without using any 
external receive (Rx) bulk attenuators on transponder or line cards. If any of the clients require Rx 
bulk attenuators, then the related channel is shown with the working condition (flagged red, orange, 
or yellow). No Rx bulk attenuator will be shown in any of the reports (such as Optical Channel 
Results, Internal Connections, or BoM). Leave unchecked to allow bulk attenuators.

 • Prevent Use of E-LEAF Dispersion—Check to prevent Cisco MetroPlanner from using E-LEAF 
dispersion compensation units (DCUs) on E-LEAF spans for the overall network. Leave unchecked 
if you want the algorithm to automatically optimize the usage of the E-LEAF DCUs.

Step 6 To define the shelf configuration parameters, click the Layout folder and complete the following:

 • Place AIC—Check to instruct Cisco MetroPlanner to put the AIC card in Slot 9 of the first shelf in 
each site.

 • Place FiberStorage—Check to instruct Cisco MetroPlanner to put the fiber storage within the rack 
below the optical shelf. 

Step 7 Click Ok.
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2.2.3  Setting the Default Project Values
Use the following procedure to set the default project settings and repair time. These defaults will appear 
during project creation.

Step 1 From the Tools menu, choose Options. 

Step 2 In the Options Explorer dialog box (Figure 2-5 on page 2-6), click Project and complete the following 
to set the defaults that appear in the Project Creation wizard:

 • Customer—Enter the default customer name (128 character maximum).

 • Created by—Enter the default user name (128 character maximum).

 • Units—Choose the desired default span length unit of measure from the drop-down list, either Km 
or Miles.

 • Price List—Choose the desired default price list.

 • Layout—Choose either ANSI (American National Standards Institute) or ETSI (European 
Telecommunications Standards Institute) from the drop-down list. 

Step 3 Click General. 

Step 4 In the MTTR (hours) field, enter the mean time to repair (MTTR) for all sites in the network. This will 
apply to every site in the network. If you change the MTTR value after creating sites, the new value will 
only apply to sites you create after the change.

Step 5 Click Ok.

2.2.4  Setting the Fiber Type Default Values
Use the following procedure to set the fiber type default values. The changes do not apply to the current 
project. After setting the values for the fiber types, you must export the database changes to a file and 
then import the file. For more information, see the “2.2.7  Exporting a File” section on page 2-16 and 
the “2.2.8  Importing a File” section on page 2-17.

Step 1 From the Tools menu, choose DB Parts Mgmt.

Note You cannot open the DB Parts Manager if a project is open. 

Step 2 In the PartsTreePanel, right-click PlatformsParts and choose Expand.

Step 3 Click parts DB for the desired release to view the fiber options for that release. The Fibres tab in the 
PartsTreePanel appears. Each item in the database contains the following information:

 • Release—(Display only) Displays the system release when the fiber type was introduced.

 • Group—(Display only) Displays the group identifier for contained items. 

 • Category—(Display only) Displays Fibre.

 • Label—(Display only) Displays the fiber types: G652-SMF, ELEAF, and TrueWave. 

 • Name—(Display only) Displays the actual part name.
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Step 4 To edit the fiber parameters, right-click on the desired row and choose Edit from the shortcut menu. The 
default values appear in a new window.

Step 5 To modify the default values, complete the following as needed:

 • name—Enter the new part name, such as Dispersion Shifted.

 • label—Enter the new fiber label, such as DS.

 • customer group—(Display only) Displays Cisco. 

 • category—(Display only) Displays Fibre.

 • release—(Display only) Displays the selected release.

 • type—Enter a new label to describe the fiber type.

 • loss factor—Type the value of the SOL fiber loss per kilometer that will be used to calculate the loss 
of each span in the network. 

 • CD factor CBand—Type the fiber chromatic dispersion default factor for the C band. 

 • CD factor LBand—Type the fiber chromatic dispersion default factor for the L band. 

 • pmd factor—Type the default polarization mode dispersion factor.

Step 6 Click Ok to save the changes and close the edit dialog box.

Step 7 Click Ok to close the PartsTreePanel dialog box.

2.2.5  Defining Third-Party DWDM Interfaces
Cisco MetroPlanner allows you to define a third-party DWDM interface to be used in project creation. 
Once you define third-pary DWDM interfaces, you can choose them when creating traffic demands.

Note If you create a network design with a third-party interface and need to share the design with other users, 
you must provide not only the saved network MPZ file but also the exported database file containing the 
third-party interface definition. To view this project, the other user first must import the database with 
the third-party interface values. 

Use the following procedure to define a third-party DWDM interface:

Step 1 Click Tools > DB Parts Mgmt. The DB Parts Manager dialog box appears.

Note You cannot open the DB Parts Manager if a project is open. 

Step 2 Right-click Platform Parts and choose Expand from the shortcut menu. 

Step 3 Right-click Group and choose New Group from the shortcut menu. The new group appears under Group 
and in each system release under parts DB. 

Step 4 In the Group Editor dialog box, complete the following:

 • Name of group—Enter the name of the new database.

 • Version of group—Displays 1.0 to indicate that this is the first version of the group. 

 • Owner—Enter the group owner name.
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 • Note—(Optional) Enter a description of the group.

Step 5 In the parts DB for the desired system release, click the group that you created.

Step 6 In the Parts tab of the DB Parts Manager dialog box, right-click and choose Client and then Alien from 
the shortcut menu. A new row appears on the Parts tab for the client hardware. 

Step 7 Double-click the row to open the Alien dialog box (Figure 2-7). 

Figure 2-7 Alien Card Dialog Box
 

Step 8 In the General tab of the Alien dialog box, complete the following:

 • Name—Type the name of the card.

 • Visible in BoM—Check if you want to include this third-party interface in the BoM.

Step 9 Click the Istance tab and complete the following:

 • Ansi PID—Enter the product identifier of the ANSI system, as needed. If you select BoM visible 
for this third-party interface with ANSI PID completed, the third-party interface is included in the 
BoM with the related product identifier.

 • Etsi PID—Enter the product identifier of the ETSI system, as needed. If you select BoM visible for 
this third-party interface with ETSI PID completed, the third-party interface is included in the BoM 
with the related product identifier.

 • TAG—(Display only) For internal use.

 • SYS. NAME ANSI—Not applicable for third-party interfaces.

 • SYS. NAME ETSI—Not applicable for third-party interfaces.

 • WL START—Choose the wavelength starting range that the third-party interface supports from the 
drop-down menu.
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 • WL END—Choose the wavelength ending range that the third-party interface supports from the 
drop-down menu.

Step 10 Click the Physical Ports tab and in the Label column, type a label for each port. 

The CTC Ports and TL1 Ports tabs are not applicable for third-party interfaces.

Step 11 Click Ok.

Step 12 In the Parts tab of the DB Parts Manager dialog box, right-click and choose Software and then Alien 
from the shortcut menu. A new row appears on the Parts tab for the client software. 

Step 13 Double-click the row to open the AlienSoft dialog box.

Step 14 In the General tab, complete the following:

 • Name—Type the name in the Name field.

 • Related Item—Choose the client card that you created in Steps 7 to 11.

Step 15 Click the Default - OCh tab (Figure 2-8).

Figure 2-8 Alien Software Dialog Box

Step 16 Complete the following (see Tables 2-1 through 2-3 for supported value combinations):

 • In the Rules area, choose the C- or L-band design rule from the Design Rule drop-down list.

 • In the Technology Area, complete the following: 

 – Modulation Format—Choose NRZ (Non Return to Zero) or Duo Binary. 

 – Transmitter Type—Choose MZ (Mach Zehnder), DML (Direct Modulated Laser) or 
EML (Electro-absorption Modulated Laser).
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 – Receiver Threshold—Choose Optimal (minimum BER) or Average (average received power).

 – Regeneration Type—Choose 3R or 2R regeneration mode.

 – FEC Mode—Choose FEC (Forward Error Correction), no FEC, or E-FEC (Enhanced FEC).

 – Transmitter Stability—Choose the maximum wavelength error allowed (pm). The values are 
12.5, 25, 50, or 100 pm.

 • Bit Rate—Choose the desired bit rate from the drop-down list.

 • In the TX Power Range area, complete the following:

 – TX Max Power—Enter the maximum power output level (dBm).

 – TX Min Power—Enter the minimum power output level (dBm).

 • In the Back to Back Receiver Sensitivity area, complete the following as needed to define the 
working interface area for Back to Back. Back to Back is a configuration where the receiver is placed 
in front of the transmitter and no other equipment exists between the two. Back to Back is used to 
measure characteristics of the TX and RX pair. Figure 2-9 shows the interface operative area.

 – Overload Power [dBm]—Enter the overload power level.

 – OL_Power [dBm]—Enter the minimum power level in the Optical Signal-to-Noise Ratio 
(OSNR)-limited range.

 – OL_OSNR [dB] on 0.5 nm RBW—Enter the minimum OSNR level in the OSNR-limited range 
(measured in .5 increments).

 – PL_Power [dBm]—Enter the minimum power level in the power-limited range.

 – PL_OSNR [dB] on 0.5 nm RBW—Enter the minimum power level in the OSNL-limited range 
(measured in .5 increments).

 • In the Chromatic Dispersion area, complete the following as needed:

 – Customize CD Robustness—Check to enable the CD Robustness field, as needed. Chromatic 
dispersion (CD) refers to the broadening of a light pulse after traveling a distance in the fiber.

 – CD Robustness [ps/(nm*km)]—If Customize CD Robustness is checked, choose the maximum 
positive dispersion, Dmax_pos [ps/(nm*km)], tolerable by the interface: 0dB, 1dB, 1.5dB, 2dB, 
or 3dB.

 • Customize Penalties—Check to enable the Gaussian Cross-Talk Penalties, Single-Interfering 
Cross-Talk Penalties, and Scale Q factors fields as needed.

 • If Customize Penalties is checked, enter the values to determine the Gaussian Cross-Talk Penalties 
in the A_GXt and B_GXt fields, as needed. Gaussion cross talk refers to random jitter that interferes 
with a signal. The A_GXt and B_GXt values are the coefficients for the exponential curves that 
estimate P-penalty(PL), P-penalty(OL), OSNR-penalty(PL), and OSNR-penalty(OL) for Gaussion 
cross-talk levels in the OL and PL regions of the interface model with dispersion margins added (see 
Figure 2-9). The formula is Penalty(GXt) = A_GXt  * exp(B_GXt *GXt). 

 • If Customize Penalties is checked, enter the values to determine the Single-Interfering Cross-Talk 
Penalties in the A_SIXt and B_SIXt fields, as needed. Single-interfering cross talk refers to 
interference caused by a single signal. The A_SIXt and B_SIXt values are the coefficients for the 
exponential curves that estimate P-penalty(PL), P-penalty(OL), OSNR-penalty(PL), and 
OSNR-penalty(OL) for single-interfering cross-talk in the OL and PL regions of the interface model 
with dispersion margins added (see Figure 2-9). The formula is Penalty(IXt) = A_SIXt* 
exp(B_SIXt* IXt).

 • If Customize Penalties is checked, enter Scale Q values in the F-P(PL), F-P(OL), F-OSNR(PL), and 
F-OSNR(OL) fields, as needed. The scale factors measure how efficient a card is in recovering the 
signal distortion. The slope of the Q-factor curve versus OSNR or RX power determines how a BER 
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increase could be recovered with an increase of OSNR, power, or both (depending in which 
OSNR/power working point the card is). In general, the scale factors are two values (one in OSNR 
and one in power) for each working point OL and PL of the interface model (see Figure 2-9). The 
the F-P(PL), F-P(OL), F-OSNR(PL), and F-OSNR(OL) values translate a Q-penalty (that is, a BER 
increase) into power and OSNR penalties. The formulas follow:

 – P-penalty(PL) = Q-penalty *  F-P(PL)

 – P-penalty(OL) = Q-penalty *  F-P(OL)

 – OSNR-penalty(PL) = Q-penalty * F-OSNR(PL)

 – OSNR-penalty(OL) = Q-penalty * F-OSNR(OL) 

F-P(PL) and F-OSNR(PL) are evaluated in the PL working region, while F-P(OL) and F-OSNR(OL) 
are evaluated in the OL working region of the curve with the dispersion margins added.  

Figure 2-9 Interface Operative Area

Table 2-1 lists the supported combinations for 40-Gbs third party interfaces.
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Table 2-1 Supported Combination for 40-Gbs Third-Party Interface

Modulation 
Format TX Type

RX 
Threshold FEC

TX 
Stability 
[pm]

Chromatic Dispersion Penalties [dBm]

P-penalty 
(OL)

OSNR- 
penalty(OL) P-penalty(PL)

OSNR- 
penalty(PL)

Duo Binary MZ Optimal E-FEC ± 12 0 1 0 1
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Table 2-2 lists the supported combinations for 10-Gbs third party interfaces.

Table 2-3 lists the supported combinations for 2.5-Gbs third party interfaces.

Step 17 Click Ok. 

2.2.6  Updating the Restricted Equipment List
Use the following procedure to modify the restricted equipment list, which contains a list of parts that 
Cisco MetroPlanner cannot use when designing the network. Restricted equipment list changes apply 
when you create a new project, however you can also update a current project with the changes.

Step 1 From the Tools menu, choose Options.

Step 2 In the Options Explorer dialog box, right-click Platform and choose Expand from the shortcut menu.

Step 3 Click Restricted Eqpt List for the desired system release. The list of cards appears in the right pane of 
the dialog box.

Step 4 To restrict a card, check the check box in the Restricted column for that card. To change the setting back 
to unrestricted, uncheck the check box. 

Step 5 Click Ok to close the dialog box. The restricted list will be used for any new projects.

Table 2-2 Supported Combinations for 10-Gbs Third-Party Interface

Modulation 
Format TX Type

RX 
Threshold FEC

TX 
Stability 
[pm]

Chromatic Dispersion Penalties [dBm]

P-penalty 
(OL)

OSNR- 
penalty(OL) P-penalty(PL)

OSNR- 
penalty(PL)

NRZ MZ Optimal E-FEC ± 25 0 2 1 0

NRZ MZ Optimal FEC ± 25 0 1.5 1 0

NRZ MZ Average no FEC ± 25 2 0 2 0

NRZ EML Average no FEC ± 100 0 3 3 0

Table 2-3 Supported Combinations for 2.5-Gbs Third-Party Interface

Modulation 
Format TX Type

RX 
Threshold FEC

TX 
Stability 
[pm]

Chromatic Dispersion Penalties [dBm]

P-penalty 
(OL)

OSNR- 
penalty(OL) P-penalty(PL)

OSNR- 
penalty(PL)

NRZ DML Average FEC ± 25 0 2 2 0

NRZ DML Average no FEC ± 25 0 2 2 0

NRZ DML Average no FEC ± 25 3 0 3 0

NRZ DML Average no FEC ± 25 3 3 3 3

NRZ EML Average no FEC ± 25 0 2 2 0

NRZ DML Average no FEC ± 100 0 3 3 0
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Step 6 To apply the changes to an existing project, complete the following:

a. If the project is not currently open, open the project where you want to update the restricted 
equipment list.

b. Right-click the folder for the network that you want to update and choose Expand from the shortcut 
menu.

c. Right-click the desired platform and release folder under RestrictedEqptListFolder in the Project 
Explorer and choose Edit List from the shortcut menu. The Restricted Eqpt list for MSTP 454 
DWDM[release 7.0] dialog box appears.

d. Click Update.

e. Click Ok to close the dialog box.

2.2.7  Exporting a File
Use the following procedure to export user options, price lists, maintenance contracts, and the parts 
database files. The Export command creates a ZIP file that includes all of the created files.

Step 1 From the Tools menu, choose Export. The Export dialog box appears (Figure 2-10).

Figure 2-10 Export Dialog Box

Step 2 In the Export dialog box, enter a file path and name in the file name field. To export to an existing file, 
click the ... button and navigate to the desired directory and file. Click Select to choose the file. 
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Step 3 To select the items to export, complete the following as needed:

 • User Option—Check to export the user options set using the Tools > Options command. 

 • PartsDB—Check the desired platforms. 

 • PriceDB—Check All Price DB to export all price lists, or expand All Price DB and check the 
individual price lists that you want to export.

Step 4 Click Ok. 

2.2.8  Importing a File
Use the following procedure to import user options, price lists, maintenance contracts, and the parts 
database files. You can import a ZIP file of multiple exported items or an individual TXT file.

Step 1 From the Tools menu, choose Import. The Import dialog box appears (Figure 2-11).

Figure 2-11 Import Dialog Box

Step 2 In the Import dialog box, click the ... button and navigate to the desired directory and file. Click Select 
to choose the file to import.

Step 3 Click load. 

Step 4 If you selected a single TXT file, skip this step and go to Step 5. If you selected a ZIP file with multiple 
exported options, complete the following as needed:

 • User Option—Leave checked to import a file with the user options that were set with the Tools > 
Options command.
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 • PartsDB—Leave checked to import the parts database for the desired platform. 

 • PriceDB—Leave All Price DB checked to import all price lists, or uncheck and check the desired 
individual price lists.

Step 5 Click Ok. 

Step 6 In the confirmation dialog box, click Ok. 

2.2.9  Resetting the Default Layout
Your graphical layout settings are saved when you exit Cisco MetroPlanner. The next time that you 
launch Cisco MetroPlanner, the layout appears as it did upon exiting. The default graphical layout 
includes items such as whether the panes are visible and/or docked, etc.

To return to the Cisco MetroPlanner default layout, choose Default Layout from the View menu. To 
restore the user modified layout, choose My Default View from the View menu. 

2.2.10  Adding Plug-ins
Use the following procedure to add plug-ins to Cisco MetroPlanner. Plug-ins are released separately 
from Cisco MetroPlanner. Using plug-ins, you can customize the released version of 
Cisco MetroPlanner. 

Step 1 Copy the plug-in file into the Documents and Settings\username\Desktop\MP7\plugins folder.

Step 2 From the File menu, choose Exit, then click Yes or No to save the existing project. 

Step 3 Launch Cisco MetroPlanner. For more information, see the “2.1  Launching Cisco MetroPlanner” 
section on page 2-1.

Step 4 Choose Tools > Plug-In > View Plugin registry. The PlugIn Registry dialog box appears (Figure 2-12).
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Figure 2-12 PlugIn Registry Dialog Box

Step 5 In the PlugIn Tree, right-click the new plug-in folder and choose Expand from the shortcut menu.

Step 6 Right-click the new plug-in and choose Run at start from the shortcut menu. 

Step 7 Click Ok.

Step 8 In the confirmation dialog box, click Ok. 

Step 9 Close Cisco MetroPlanner and restart. The new plug-in appears as a command under the File menu.

2.2.11  Managing Plug-ins
Use the following procedure to view and manage plug-ins. For information about adding plug-ins, see 
“2.2.10  Adding Plug-ins” section on page 2-18.

Step 1 Choose Tools > Plug-In > View Plugin registry. The PlugIn Registry dialog box appears (Figure 2-12 
on page 2-19). 

Step 2 In the PlugIn Tree, right-click the plug-in folder and choose Expand from the shortcut menu. 

Step 3 Click a plug-in to view information about it. The right pane of the PlugIn Registry dialog box displays 
the plug-in information.

 • The General area of the PlugIn Registry dialog box identifies the following information:

 – Name—(Display only) Displays the name of the plug-in.

 – Path—(Display only) Displays the location of the plug-in.
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 – Version—(Display only) Displays the version of the plug-in.

 – Provider—Displays the name of the supplier of the plug-in.

 – Text—(Display only) Displays a brief description of the plug-in.

 – Exclusion—(Display only) Displays the exclusion label. The exclusion attribute is a tag that 
defines an exclusion rule for a plugin. No more that one plugin with a given exclusion tag can 
be run at the same time.

 • The State area of the PlugIn Registry dialog box identifies the plug-in current state and restrictions:

 – Current State—(Display only) Identifies the state of the plug-in.

 – Can be stopped—(Display only) If True, you can disable the plug-in during the current session 
of Cisco MetroPlanner. The plug-in will disappear from the File menu. To restart a plug-in that 
has been stopped, you must exit and relaunch Cisco MetroPlanner. If False, you cannot stop the 
plug-in during an active Cisco MetroPlanner session. 

 – Can be suspend—(Display only) If True, you can disable the plug-in during the current session 
of Cisco MetroPlanner. The plug-in will disappear from the File menu. To restart a plug-in that 
has been suspended, you can choose Resume in the PlugIn Registry dialog box. It is not 
necessary to exit and relaunch Cisco MetroPlanner. If False, you cannot suspend and resume 
this plug-in during an active Cisco MetroPlanner session.

 • The Run Information area of the PlugIn Registry dialog box displays the Can be deactivated state. 
If True, you can deactivate a plug-in but must exit and relaunch Cisco MetroPlanner for the 
deactivation to take effect. When you relaunch Cisco MetroPlanner, the plug-in will not appear in 
the File menu. If False, you cannot deactivate this plug-in. 

Step 4 To disable or suspend a plug-in, right-click the plug-in and choose one of the following from the shortcut 
menu:

 • Do not run at start—Choose to disable the plug-in the next time Cisco MetroPlanner is launched. 

 • Suspend/Resume—Choose Suspend if you want to disable the plug-in immediately without 
restarting Cisco MetroPlanner. Choose Resume to enable a suspended plug-in.

Step 5 Click Ok.

Step 6 In the confirmation dialog box, click Ok. 

Step 7 If you chose Do not run at start, exit and relaunch Cisco MetroPlanner for the plug-in to be disabled.

2.2.12  Adding User Profiles
A user profile is a set of privileges used for running Cisco MetroPlanner. Each profile offers different 
capabilities. Cisco MetroPlanner is packaged with the Network Designer and Base Network Designer 
profiles, but you can add other user profile types.

Table 2-4 lists the privileges that differ between the Network Designer and the Base Network Designer 
user profiles. For all other commands and options, the two user profiles have the same privileges.

Table 2-4 Different Privileges for Network Designer and Base Network Designer 

Cisco MetroPlanner Command/Option Network Designer Base Network Designer

Tools > Parts Database > New group Yes No

Tools > View Plug-in registry Yes Yes
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Use the following procedure to add a user profile to Cisco MetroPlanner:

Step 1 Copy the profile JAR file into the Documents and Settings\username\Desktop\MP7\profiles folder.

Step 2 Launch Cisco MetroPlanner. For more information, see the “2.1  Launching Cisco MetroPlanner” 
section on page 2-1. The new profile should appear in the Choose a profile type drop-down list.

2.2.13  Running a Script
Use the following procedure to run a script. A script is a sequence of commands in a BSH file format 
that is used to provide additional Cisco MetroPlanner capabilities. Cisco provides scripts to help you 
customize your Cisco MetroPlanner software. 

Step 1 From the Script menu, choose Run Script.

Step 2 In the Choose the script to run dialog box, click the desired script and click Open. The script runs.

2.3  Creating a Project
A project consists of a single network or multiple networks that you analyze and compare. In a project, 
you can have multiple copies of a single network with the same customer input data, but use different 
options in each to investigate multiple solutions. 

Use the following procedure to create a single network in a project. A new network is in the Design state. 
For more information about the different network states, see the “2.7  Managing the Network Design” 
section on page 2-77.

Step 1 From the File menu, choose New. The Project Creation Wizard appears (Figure 2-13).

Tools > Options > Platform Options > Restricted 
Equipment list

Yes Read only

Tools > Price List Mgmt > Master Price Database Yes Read only

Tools > Export Yes Yes

Tools > Import Yes Yes

Table 2-4 Different Privileges for Network Designer and Base Network Designer (continued)

Cisco MetroPlanner Command/Option Network Designer Base Network Designer
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Figure 2-13 Project Creation Wizard 

Step 2 On the Project page, complete the following:

 • Created By—Displays the user login name. You can edit this field (128 character maximum).

 • Customer Name—Type the name of the customer (128 character maximum) requiring this network 
design. 

 • Network Platform Layout—Choose ANSI (the North American standard) or ETSI (the international 
standard) from the drop-down list to indicate the platform type. ANSI networks will not allow you 
to define SDH (ETSI) service demands. ETSI networks will not allow you to define SONET (ANSI) 
service demands. 

 • Span Measurement Units—Choose Km (kilometers) or Miles from the drop-down list to set the unit 
of measure used for span length.

 • Price List—Choose the price list from the drop-down list. 

Step 3 Click Next.

Step 4 On the Platform page, check the desired platform and click Next.

Step 5 On the Release page, check the desired software release for the network design and click Next. The 
default is the latest release. This attribute defines the list of hardware parts that cannot be used in the 
design because they are not supported by a particular release. 

Step 6 On the Subnet page, complete the following (Figure 2-14):

 • Traffic mapping—Check to select the ONS 15454 Release 7.0 version of the interface and 
wavelength routing optimization algorithm to be used in the network design. Release 7.0 is 
backward compatible and can manage Software Release 4.7, 5.0, and 7.0.

 • Metro Core—Check to select the ONS 15454 Release 7.0 version of the algorithm used to optimize 
the amplifier and DCU placement within the subnetwork. Release 7.0 is backward compatible and 
can manage Software Release 4.7, 5.0, and 7.0.
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 • Layout—Check to define the ONS 15454 Release 7.0 version of the algorithm used to generate the 
layout of each site within the subnetwork. Release 7.0 is backward compatible and can manage 
Software Release 4.7, 5.0, and 7.0.

 • Bands—Choose C-Band or L-Band. L-Band is available only for Release 7.0 networks.

 • Scalable C/L Bands—Choose Yes or No to specify if the design will be scalable to support both 
C-band and L-band on the same system. This option is available only for Release 7.0 networks. 

 • Scalable C-band/50GHz—Choose Yes or No to specify if the design will be scalable to support 
50-Ghz channel spacing in C-band. This option is available only for Release 7.0 networks. 

 • C-band Rules—Choose the option that will be the maximum per-channel power and channel spacing 
for the network design. This option is available when the selected band is C-band.

 • L-band Rules—Choose the option that will be the maximum per-channel power and channel spacing 
for the network design. This option is available when the selected band is L-band or when 
Scalable C/L Bands is set to Yes. 

Figure 2-14 Project Creation Wizard Subnet Page

Step 7 Click Next.

Step 8 Complete one of the following:

 • To run the Network Creation wizard, check the Run the Network Wizard Now check box and click 
Finish. Continue with Step 9.

 • To create an empty project to add sites and fibers manually, uncheck the Run the Network Wizard 
Now check box and click Finish. Project Wizard creates the project and an empty network and 
subnetwork under which you can manually add sites and fibers. Skip the remaining steps in this 
procedure. To add sites manually, see the “2.3.1  Adding Sites” section on page 2-27.
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Step 9 In the Topology page of the Network Creation wizard (Figure 2-15), choose Ring or Linear from the 
Topologies drop-down list and click Next.

Figure 2-15 Network Creation Wizard Topology Page

Step 10 On the Configuration page, enter the number of sites in the Site number field and click Next. The 
maximum number of sites per network design is 60 sites and the default is 3 sites.

Step 11 On the Site Management page, complete the following (Figure 2-16):

 • Shelf Management—Choose the shelf management configuration:

 – Multi Shelf Integrated Switch—All the Multi Service Transport Platform (MSTP) optical cards 
(optical add/drop multiplexers [OADMs] and amplifiers) reside in different shelves connected 
by a LAN. The LAN is implemented with switches connected to the MSTP shelves. 

 – Multi Shelf External Switch—All the MSTP optical card (OADMs and amplifiers) reside in 
different shelves connected by a LAN. The LAN is implemented with switches external to the 
MSTP shelves.

 – Individual Shelf—All the MSTP optical cards (OADMs and amplifiers) reside in the same shelf. 

 • Node Protection—Choose Same Shelf (single shelf configurations) or Separated Shelves 
(multishelf configurations). Same Shelf is the only option if you chose Individual Shelf as the Shelf 
Management type.

 • Hybrid Node—Check to create all the nodes configured as hybrid MSTP/Multi Service Provisioning 
Platform (MSPP) nodes. Hybrid Node is only available if you chose Individual Shelf as the Shelf 
Management type.

 • Osmine Compliant—Check to create all the nodes in the network design with transponder and line 
cards that are compliant with Operations Systems Modifications of Intelligent Network Elements 
(OSMINE).
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 • DCC chain—Check to put a TXP(P)_MR_2.5G card in Slot 12 on each shelf of each site. This 
option is available for individual shelves.

 • Max Shelf Num—Choose the maximum number (from 1 to 4) of ANSI or ETSI shelves (equipping 
optical cards or TXP/MXP card) that can be placed in each rack in the site when generating the 
layout of the site. 

Figure 2-16 Network Creation Wizard Site Management Page

Step 12 Click Next.

Step 13 In the Span Parameters, complete the following (Figure 2-17):

 • Span Label Tag—Type the desired span label; the default label is Duct.

 • Span Fibre Type—Choose the fiber type for each span in the network.

 • Span Length—Type the span length. The displayed unit of measure is retrieved from the 
Span Measurements Units field.

 • EOL Ageing Factor—Type the number to use when factoring fiber aging. This factor is multiplied 
by the SOL total span loss without connectors. 

 • EOL Ageing loss [dB]—Type the EOL aging loss value. The EOL loss-per-span value is added at 
the end of life to each discrete fiber in the network (for example, to add an EOL margin for splicing).

Note Enter a value in either EOL Ageing Factor or EOL Ageing loss; you do not need to enter a 
value in both fields.

 • Connector loss [dB]—Type the concentrated loss at the end of the span.
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 • CD factor [ps/mn/km]—Type the fiber chromatic dispersion (CD) factor. The default value is 
dependent on the selected fiber type. Any value that you enter in this field is lost whenever you 
change the fiber type. Chromatic dispersion is always entered in ps/nm/km. Fiber chromatic 
dispersion is defined for the middle of the wavelength band. C-band is defined at 1545.3 nm; L-band 
is defined at 1590.4 nm.

 • PMD factor [ps/sqrt(km)]—Type the polarization mode dispersion (PMD) factor. The default value 
is dependent on the selected fiber type. Any value that you enter in this field is lost whenever you 
change the fiber type. PMD is always entered in kilometers. 

 • Length Based Loss—Check to define whether the fiber loss is specified as an absolute value or 
derived from the span length.

 • Loss factor [dB/km]—Type the value of the SOL fiber loss per kilometer that is used to calculate 
the loss of each span in the network. The fiber loss factor is always entered in dB/km.

 • Tot SOL loss w/o conn [dB]—Type the start of life link fiber loss for each span, without the 
connector concentrated loss. The total SOL loss without connectors is equal to the loss factor 
multiplied by the length. In the Length Based model, this value is calculated automatically.

Figure 2-17 Network Creation Wizard Span Parameters Page

Step 14 Click Finish. Cisco MetroPlanner checks the validity of the fiber factor values. If the fiber factor values 
are within the valid range (Table 2-5), Cisco MetroPlanner creates a visual representation of the 
network. If the values are out of range, Cisco MetroPlanner issues a warning, asking you to confirm the 
input values.
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2.3.1  Adding Sites 
Use the following procedure to add new sites to an existing network. A site is a customer premise 
location where any equipment can be co-located in a rack within a building.

Note Cisco MetroPlanner supports up to 60 sites. However, the ONS 15454 DWDM platform will only 
support up to 16 non-pass-through sites on any given network. Although Cisco MetroPlanner will allow 
you to add more than 16 sites, it will generate errors when the network analysis runs.

Step 1 Right-click the network folder in the Project Explorer and choose Expand from the shortcut menu.

Table 2-5 Valid Ranges for Fiber Factor Values 

Fiber Type Parameter

Min. 
Error 
Value

Min. 
Warning 
Value

Default 
Value

Max. 
Warning 
Value

Max. 
Error 
Value Unit

ITU-T 
G.652-SMF

Loss factor 0 0.2 (*) 0.4 10 dB/km

Chromatic 
dispersion factor 
at 1545.3 nm 
(C-band)

0 16.2 16.7 17.1 30 ps/nm/km

Chromatic 
dispersion factor 
at 1590.4 nm 
(L-band)

0 18.53 19.03 19.43 30 ps/nm/km

PMD factor 0 ps/ 0.0 0.1 0.5 10

ITU-T 
G.655-E-LEAF

Loss factor 0 0.2 (*) 0.4 10 dB/km

Chromatic 
dispersion factor 
at 1545.3 nm

0 3.4 3.80 4.2 10 ps/nm/km

PMD factor 0 0 0.1 0.5 10

ITU-T 
G.655-True 
Wave

Loss factor 0 0.2 (*) 0.4 10 dB/km

Chromatic 
dispersion factor 
at 1545.3 nm

0 3.8 4.19 4.6 10 ps/nm/km

PMD factor 0 0 0.1 0.5 10

ITU-T 
G.652-DS 
(Dispersion 
shifted)

Loss factor 0 0.2 (*) 0.4 10 dB/km

Chromatic 
dispersion factor 
at 1590.4 nm 
(L-band)

0 2.43 2.83 3.23 30 ps/nm/km

PMD factor 0 0 0.1 0.5 10
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Step 2 Right-click the Sites folder and choose New Site from the shortcut menu. The Site Creation wizard 
appears. As an alternative, if sites already exist in the network design and you have the NtVw Net# tab 
open, click the Create a new site icon in the toolbar. For more information about the Cisco MetroPlanner 
icons, see Appendix A, “GUI Information and Shortcuts.”

Step 3 Choose the interface type:

 • Line—Two pairs of fibers are terminated at the node.

 • Terminal—A single pair of fibers is terminated at the node.

 • Line+—Two pairs of fibers are terminated at the node but the number of fibers can be increased. An 
MMU card (topology upgrade) must be installed.

 • Terminal+—A single pair of fibers is terminated at the node but the number of fibers can be 
increased. An MMU card (topology upgrade) must be installed.

Step 4 Click Finish. 

2.3.2  Deleting Sites
Use the following procedure to delete sites from a network. You can delete a site if the site is in the 
Unlocked state and does not have a traffic demand set up on it.

Step 1 Verify that the site is in the Unlocked state in the Project Explorer pane. For more information, see the 
“2.7.4  Unlocking Parameters in the Network Design” section on page 2-80.

Step 2 Delete any traffic demands. For more information, see the “2.6.9  Deleting a Traffic Demand” section 
on page 2-71.

Step 3 On the NtVw Net# tab, click the Site icon and choose Delete from the Tasks Pane. For more information 
about the Cisco MetroPlanner icons, see Appendix A, “GUI Information and Shortcuts.”

2.3.3  Adding Fiber Spans
Use the following procedure to manually add fiber spans between sites. A fiber span consists of a pair 
of fibers (one transmit and one receive) between two sites. A span is represented by a fiber duct in the 
NetView Net# tab. Within a fiber duct, more than one fiber pair can exist. 

Step 1 In the NtView Net# tab, click the Create a new duct icon in the toolbar. For more information about the 
Cisco MetroPlanner icons, see Appendix A, “GUI Information and Shortcuts.”

Step 2 Click one of the sites that you want to connect with a fiber span. This site will be the source site for later 
network analysis output. 

Step 3 Click the destination site. A fiber span appears between the two sites. This site will be the destination 
site for later network analysis output. 

For the first span, the source site is set as East and the destination site is set as West. Cisco MetroPlanner 
automatically adjusts East and West for additional spans.
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2.3.4  Creating a Point-to-Point Demand
Use the following procedure to add a point-to-point traffic demand:

Step 1 In the NtView Net# tab, click the Create a new P2P demand icon in the toolbar. For more information 
about the Cisco MetroPlanner icons, see Appendix A, “GUI Information and Shortcuts.”

Step 2 Click the source site of the demand. 

Step 3 Click the destination site of the demand. The Point to Point Demand Creation Wizard appears 
(Figure 2-18).

Figure 2-18 Point to Point Demand Creation Wizard

Step 4 In the General Parameters area, complete the following:

 • Label—Type the name of the demand.

 • Source—(Display only) Displays the source site name.

 • Destination—(Display only) Displays the destination site name.

 • Service Type—Choose the service type from the drop-down list. For a list of services, see the 
“1.2.6  Service Support” section on page 1-4.

 • Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically 
updates with the number entered in this field.

 • Forecast # ch—Enter the number of channels to be installed at a later date. This value includes the 
Present # ch value. For example, if you entered 4 in the Present # ch value and want to add two 
channels in the future, enter 6.

Step 5 Click Next.
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Step 6 In the Platform Parameters area, complete the following:

 • Protection—Choose the protection type from the drop-down list: Y-Cable Protected, Client 1+1, 
Fiber Switched, or Unprotected. For more information on protection types, see the 
“1.2.5  Protection Scheme Support” section on page 1-3.

 • Path—(Unprotected only) Choose the routing type from the drop-down list:

 – Auto—Allows the highest degree of flexibility in routing the channels. Cisco MetroPlanner 
routes the channels with the lowest possible cost given the other constraints.

 – EAST->WEST—Routes all the channels from the east side of the source site. 

 – WEST->EAST—Routes all the channels from the west side of the source site.

 • Optical Bypass—(Unprotected only) Choose the site where the channels for the current demand will 
be optically dropped. 

Step 7 Complete the following fields in the Interface Parameters area. The options available are based on the 
service type selected in Step 4.

 • Transponder—Click to expand, then check the card type check box to select the card at the end sites 
of the service channels.

 • Line Card—Click to expand, then check the card type check box to select the card at the end sites 
of the service channels.

 • Alien Card—Displays only if you created a third-party interface as described in the “2.2.5  Defining 
Third-Party DWDM Interfaces” section on page 2-10. Click to expand, and then check the card type 
check box to select the card at the end sites of the service channels.

 • Pluggable Card—Click to expand, then check the card type check box to select the card at the end 
sites of the service channels.

Step 8 In the Client Interface area, define the client interface type (SR, IR, or LR) for the source and destination 
from the Source and Destination drop-down lists. This option is available only for transponder interfaces 
and depends on the selected service type and card type. 

Step 9 Click Finish. The Edit Point to Point Demand dialog box appears listing the present and forecast 
channels. 

The demand appears in the NtVw Net# tab. A demand is a solid line when selected and a dotted line 
when not selected. The line has a number above it that indicates the number of channels that are present. 
Figure 2-19 shows a selected point-to-point demand with five channels between Sites 1 and 2. 

Note To make changes to the demand parameters, see the “2.6.6  Editing a Point-to-Point Demand” section 
on page 2-67, or click Cancel to close the Edit Point to Point Demand dialog box. 

Figure 2-19 Point-to-Point Demand Between Two Sites 
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2.3.5  Creating a Protected Ring Demand
Use the following procedure to create a P-ring traffic demand.

Step 1 Create a ring network using either the procedures in the “2.3  Creating a Project” section on page 2-21 
or by manually placing sites into a ring configuration.

Step 2 In the Native Net# tab, click the Create a new P-Ring demand icon in the toolbar. The P-Ring Creation 
Wizard appears (Figure 2-20). For more information about the Cisco MetroPlanner icons, see 
Appendix A, “GUI Information and Shortcuts.”

Figure 2-20 P-Ring Creation Wizard

Step 3 In the General Parameters area, complete the following:

 • Label—Enter the name of the demand.

 • Service Type—Choose the service type from the drop-down list. For a list of services, see the 
“1.2.6  Service Support” section on page 1-4.

 • Present # ch—Enter the number of channels to be created. The Forecast # ch field automatically 
updates with the number entered in this field.

 • Forecast # ch—Enter the number of channels to be installed at a later date. This value includes the 
Present # ch value. For example, if you entered 4 in the Present # ch value and want to add two 
channels in the future, enter 6.

Step 4 Click Next.

Step 5 In the Protection Sites area, press Ctrl and click the sites that you want to add to the P-ring. A P-ring 
requires at least three sites. Click the right arrow button. 
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Step 6 In the Optical Bypass area, press Ctrl and click the sites that you want to add to the P-ring. Click the 
right arrow button.

Step 7 Click Next.

Step 8 Complete the following interface parameters. The options available are based on the service type 
selected in Step 3.

 • Transponder—Click to expand, then check the card type check box to select the card at the end sites 
of the service channels.

 • Line Card—Click to expand, then check the card type check box to select the card at the end sites 
of the service channels.

 • Alien Card—Displays only if you created a third-party interface as described in the “2.2.5  Defining 
Third-Party DWDM Interfaces” section on page 2-10. Click to expand, and then check the card type 
check box to select the card at the end sites of the service channels.

 • Pluggable Card—Click to expand, then check the card type check box to select the card at the end 
sites of the service channels.

Step 9 In the Client Interface area, define the client interface type (SR, IR, or LR) for the source and destination 
from the Source and Destination drop-down lists. This option is available only for transponder interfaces 
and depends on the selected service type and card type. 

Step 10 Click Finish. The Edit P-Ring Demand dialog box appears.

The demand appears in the NtVw Net# tab. A demand is a solid line when selected and a dotted line 
when not selected. The line has a number above it that indicates the number of channels present. 
Figure 2-21 shows a selected one-channel P-ring between Sites 1, 2, 3, and 5 with an optical bypass of 
Site 4. 

Note To make changes to the demand parameters, see the “2.6.7  Editing a P-Ring Demand” section on 
page 2-68, or click Cancel to close the Edit P-Ring Demand dialog box. 
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Figure 2-21 P-Ring Demand

2.3.6  Creating a ROADM Demand
Use the following procedure to create ROADM traffic groups and demands:

Step 1 In the Project Explorer, right-click the Groups folder and choose Expand from the shortcut menu.

Step 2 Right-click the ROADM folder and choose Create new ROADM group from the shortcut menu. The 
ROADM Group Creation Wizard appears.

Step 3 Type the ROADM traffic group name in the Group Name field. 

Step 4 Check the desired sites.

Step 5 Click Finish. The new ROADM traffic group appears under the ROADM folder in the Project Explorer.

Step 6 Right-click the new ROADM traffic group and choose Create new ROADM demand from the shortcut 
menu. The Create ROADM Demand dialog box appears (Figure 2-22).
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Figure 2-22 Create ROADM Demand Dialog Box 

Step 7 Enter a name for the demand in the Demand Name field. 

Step 8 Select a traffic pattern type (Hub or Meshed) from the Traffic Type drop-down list. If you select Hub, 
the First Site drop-down list becomes available. If you selected Meshed, proceed to Step 10.

Step 9 For Hub traffic types, select the originating site from the First Site drop-down list.

Step 10 Select a connectivity type from the Connectivity type drop-down list: Protected, Unprotected 
Minimum Hop, Unprotected Optimum Path, or Unprotected Subnet. Refer to the “1.5.3  ROADM 
Traffic Groups” section on page 1-9 for more information on the connectivity choices. If you chose 
Unprotected Subnet, continue with the next step; otherwise proceed to Step 12.

Step 11 If you chose Unprotected Subnet, choose the starting site and the direction the ring must be traversed 
from the drop-down lists. 

Step 12 In the Service Types list, check the boxes for one or more client service types for the ROADM demand. 
The client interfaces that support each service type appear in the table to the right of the Service Types 
list.

Step 13 To further define the client interfaces, complete the following options for each client interface listed in 
the table. Check boxes in gray are not available for selection.

 • Yes/No—Check to select this card to implement the service type.

 • Client Interface—(Display only) Displays the card type for the selected service type.

 • Y Protected—Check to select Y-cable protection if the connectivity type is Protected.

 • 1+1 Protected—Check to select 1+1 protection if the connectivity type is Protected.

 • Fiber Switched—Check to select fiber-switching protection if the connectivity type is Protected.

 • Supported Service—(Display only) Displays the service types supported for the card.

You can select more than one client interface to support the same service type. By default, 
Cisco MetroPlanner checks the best client interface to support each service. 

Step 14 Click Ok to create the demand.
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2.3.7  Deleting a Network
To delete a network from a project, in the Network Mgmt Tree tab click the network and choose Delete 
from the Tasks Pane. You cannot delete a network if it is the only network in a project.

2.3.8  Adding Notes to a Project
Use the following procedure to add a note to any item in the Project Explorer. Each network has a Notes 
folder in the Project Explorer. After you have created a note, it appears in the Notes folder for that 
particular network. 

Step 1 Right-click the desired item in the Project Explorer and choose Edit Note from the shortcut menu.

Step 2 In the Edit Note creation box, enter the desired text. 

Step 3 To close the Edit Note creation box and to save the note, click the X in the upper right corner of the 
window.

Step 4 To view notes, double-click the Notes folder. The Notes window appears. Table 2-6 lists the columns in 
the Notes window.

Step 5 To close the Notes window, click the X in the upper right corner of the window.

2.3.9  Deleting Notes
Use the following procedure to delete a note from any item in the Project Explorer:

Step 1 Double-click the Notes folder.

Step 2 In the Notes window, click Go in the Action column for the note that you want to delete. The item is 
highlighted in the Project Explorer. 

Step 3 Right-click the item in the Project Explorer and choose Delete Note from the shortcut menu.

Table 2-6 Notes Window 

Column Description

Header Displays the note text. To view the entire note, click the plus (+) sign next to the header 
to expand the text.

Action Click Go to open the item in the Project Explorer where the note was created.

Source Displays the location of the note, for example, ProjectManager.Nets.Net2.Sites.Site2.W.
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2.4  Analyzing the Network
After you have created the desired sites, fiber spans, and service demands, you must analyze the network 
to determine network performance. The network must be in the Design, Install, or Upgrade state before 
you can analyze it. Cisco MetroPlanner automatically optimizes the design and summarizes the optical 
transmission performance. If there are problems with the design, Cisco MetroPlanner lists the problems 
and descriptions in the Analyzer Messages pane. 

Use the following procedure to analyze the network:

Step 1 Click the Networks Mgmt Tree tab, and click the network that you want to analyze.

Step 2 Click the Analyze Network icon in the toolbar. For more information about the Cisco MetroPlanner 
icons, see Appendix A, “GUI Information and Shortcuts.” As an alternative, click Analyze in the Tasks 
Pane. 

The MetroPlanner analyzer status window appears to indicate the progress. The Cisco MetroPlanner 
analysis status bar indicates when the network analysis is complete. 

Step 3 If any problems occur during the analysis, click the Analyzer tab to view the results on the Analyzer 
Messages pane. The Summary report appears. See the “2.5.1  Viewing the Summary Report” section on 
page 2-37 for more information. 

Step 4 If necessary, resolve the problems listed in the Summary report. After you resolve the problems in the 
network, you can analyze the network again. 

Note You can return a Design-Analyzed network to the design state to make further changes by clicking the 
network icon in the Networks Mgmt Tree and clicking Design in the Tasks Pane. 

2.5  Viewing Network Reports
Cisco MetroPlanner provides the reports listed in Table 2-7. Report availability depends on whether a 
network has been analyzed or whether it is in the Install or Upgrade state. Reports are also available by 
site. See Table 2-7 for report availability details.

Table 2-7 Report Availability 

Report Network Availability Site Availability

NE Update Analyzed —

Installation Parameters Analyzed Analyzed 

Traffic Matrix Analyzed Analyzed

Layout Install, Upgrade, and Analyzed Install, Upgrade, and Analyzed

Link Availability Analyzed Analyzed

Internal Connections Analyzed —

Optical Results Analyzed Analyzed

Wavelength Routing Analyzed —
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For more information on the Bill of Materials report, see the “2.8  Generating a BoM” section on 
page 2-80. In addition, you can compare the following reports using the Reports Diff tool: Bill of 
Material, Internal Connections, and Installation Parameters. 

To complete the procedures in this section, you must have a project open and the network(s) loaded. See 
the “2.1.1  Opening a Project” section on page 2-3 and the “2.1.2  Loading and Unloading Networks” 
section on page 2-3.

2.5.1  Viewing the Summary Report
The Summary report summarizes design information, optical results, design cost, and analyzer 
messages. You can view it before or after you analyze a network. It automatically appears when you 
analyze a network. Use the following procedure to view the report at another time:

Step 1 Complete one of the following:

 • To view the Summary report for a network, click the Networks Mgmt Tree tab and click the 
network.

 • To view the Summary report for a site, click the NtView Net# tab and click the site.

Step 2 In the Tasks Pane, click Summary. The Summary tab appears (Figure 2-23).

Summary Install, Upgrade, and Analyzed Install, Upgrade, and Analyzed

Bill of Material Install, Upgrade, and Analyzed Install, Upgrade, and Analyzed

Table 2-7 Report Availability (continued)

Report Network Availability Site Availability
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Figure 2-23 Summary Tab

Table 2-8 lists the categories in the Summary tab and their descriptions. 

Table 2-8 Summary Tab Categories 

Category Description

Design info Displays the following information:

 • Version—Displays the Cisco MetroPlanner software release version.

 • Customer name—Displays the name of the customer requiring this network 
design. 

 • Created By—Displays the user login name. 

 • Release—Displays the Cisco MetroPlanner software release number.

Optical results Indicates how many demands are included in the network, and identifies the number 
and severity of alarms for each demand. 
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2.5.2  Saving the NE Update File
After Cisco MetroPlanner calculates the installation parameters, you can create a configuration file in 
XML format for each site in the network. This file can be directly imported to a site using the NE Update 
feature in CTC. CTC uses this file to preprovision a node. 

Cisco MetroPlanner generates one text file for each site in the network in the Cisco MetroPlanner 
installation folder. Each file is named with the site name string by default. File data format and the list 
of reported installation parameters depend on the system release selecteded for the designed network. 
You generally save this file after you analyze an Install network.

Use the following procedure to save the NE Update file:

Step 1 Click the Networks Mgmt Tree tab, and click the analyzed network.

Step 2 In the Tasks Pane, click NE Update. The Network Element Update File dialog box appears.

Step 3 Check the Include wavelength parameters check box to include trunk wavelength preprovisioning in 
the NE Update XML file. Do not check this box if the network on which you import the NE Update file 
is using system release 7.0.0. If this option is checked, trunk wavelength is preprovisioned in CTC for 
all the TXP and MXP units required to support present traffic demands. 

Note During project creation, selecting MSTP- Release 7.0 allows you to create projects for system 
releases 7.0.0 and 7.0.x. However, when importing the NE Update file on a node using system 
release 7.0.0, the node cannot read the NE Update XML file if Include wavelength parameters 
is checked.

Step 4 To save the file in a different directory than the Destination Folder, click Change and navigate to the 
desired directory. Click Save. 

Step 5 Click Finish.

Design cost info Displays the following information:

 • Price list—Displays the price list used.

 • Currency—Displays the currency selected for the price list.

 • BoM total discounted—Displays the total price of the products (excluding spare 
parts) in the network with the discount applied.

 • Spare total discounted—Displays the total price of the spare parts in the 
network with the discount applied

 • BoM + Spare total discounted—Displays the total price of the products 
(including spare parts) in the network with the discount applied.

Messages Displays any analyzer messages that occurred as a result of network analysis.

Table 2-8 Summary Tab Categories (continued)

Category Description
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Step 6 Click Cancel to close the window without saving a configuration setup file.

2.5.3  Viewing the Installation Parameters 
The Installation Parameters reports shows the values to be set (provisioned) at installation time on each 
site in the network. These parameters are exported when you save the NE Update file and are used to 
automatically provision a node using CTC. 

Use the following procedure to view the installation parameters after a network has been analyzed:

Step 1 Complete one of the following:

 • To view the Installation Parameters report for a network, click the Networks Mgmt Tree tab and 
click the network.

 • To view the Installation Parameters report for a site, click the NtView Net# tab and click the site.

Step 2 In the Tasks Pane, click Installation Parameters. The Installation Parameters tab appears (Figure 2-24). 
The ANS view subtab appears by default. This tab displays the automatic node setup information.

Figure 2-24 ANS View Subtab in the Installation Parameters Tab 

Table 2-9 describes the columns on the ANS view tab of the Installation Parameters report. 

Table 2-9 Installation Parameters Report ANS View Tab Columns 

Category Description

Name Displays the name of the site. 

Side Displays the node interface: T (terminal), E (east), or W (west).

Position Displays the rack, shelf, and slot position of the card from which the patchcord 
originates.

Unit Displays the name of the card.

Port # Displays the port number from which the patchcord originates.
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Step 3 Click the ANP view tab to view the automatic node provisioning information. Table 2-10 describes the 
columns on the ANP view tab of the Installation Parameters report. 

Step 4 Click the PP view tab to view the provisioning parameters information. Table 2-11 describes the 
columns on the PP view tab of the Installation Parameters report. 

Step 5 To close the Installation Parameters report, click the X on the top right of the Installation Parameters tab.

Port ID Displays the port ID.

Port Label Displays the name of the port.

Parameter Displays the name of the parameter to be set, such as RX Power Low.

Value Displays the name of the value to be set.

Measurement 
Unit

Displays the measurement unit for the related installation parameter value, such as 
dBm.

Manual Set Indicates with a Yes or No which parameters must be manually set using the CTC 
interface.

Table 2-10 Installation Parameters Report ANP View Tab 

Category Description

Name Displays the name of the site. 

Shelf ID Displays the shelf identifier.

Rack number Displays the rack number.

Rack position Identifies the rack position in the shelf.

Slot position Identifies the slot position in the shelf for the card.

Equipment type Displays the card type.

Table 2-11 Installation Parameters Report PP View Tab 

Category Description

Name Displays the name of the site. 

Shelf ID Displays the shelf identifier.

Slot position Displays the slot number for the card with the PPM.

Port position Displays the port number.

Ppm position Displays the PPM location on the card.

Pp name Displays the name of the PPM. 

value Displays the installation parameter value.

Table 2-9 Installation Parameters Report ANS View Tab Columns (continued)

Category Description
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2.5.4  Viewing Internal Connections
Use the following procedure to view the network internal connections after a network has been analyzed.

You can also use this procedure to view the patchcord connections between transponders and the 
Y-Cable Protection FlexLayer modules. The Y-Cable Protection FlexLayer position is defined using the 
rack and shelf number. The slots are numbered from left to right on each of the four FlexLayer modules 
that can be placed in a shelf.

Step 1 Click theNetworks Mgmt Tree tab, and click the analyzed network.

Step 2 In the Tasks Pane, click Internal Connections. The Internal Connections tab appears (Figure 2-25).

Figure 2-25 Internal Connections Tab 

Table 2-12 lists the columns in the Internal Connections tab and their descriptions. Click a columns to 
sort the table information by that column.

 • Click the Patchcord installation view subtab to view all the patchcord connections that the installer 
has to mechanically cable within the site between the different ports of the cards. 

 • Click the SW Provisioning view subtab to view the patchcord representation on the local Cisco 
Transport Controller (CTC) interface. This subtab contains all the connections to be manually set or 
removed with respect to the default connections that are automatically generated by the software 
running on the node. 
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Step 3 To export the information to an external file, click Export. In the Internal connections export dialog box, 
type the name of the file and navigate to the desired folder. Click Save.

Step 4 To close he Internal Connections tab, click the X in the upper right corner of the tab.

2.5.5  Viewing the Traffic Matrix Report
The Traffic Matrix report displays the point-to-point, P-ring, and ROADM channel data. Use the 
following procedure to view the traffic matrix report:

Step 1 Complete one of the following:

 • To view the Traffic Matrix report for a network, click the Networks Mgmt Tree tab and click the 
network.

 • To view the Traffic Matrix report for a site, click the NtView Net# tab and click the site.

Step 2 In the Tasks Pane, click Traffic Matrix. The Traffic Matrix tab appears.

Step 3 Click New Query to open the Query Dialog (Figure 2-26). The Query Dialog allows you to filter the 
optical results using a variety of parameters and templates.

Table 2-12 Internal Connections Tab Columns 

Column Name Description

Name Displays the name of the site. On the SW provisioning view subtab, this column 
indicates whether the connection should be manually set using the CTC interface or 
removed.

Position-1 Displays the rack, shelf, and slot position of the card from which the patchcord 
originates.

Unit-1 Displays the name of the card.

Port Num (SW provisioning view subtab only) Displays the port number where the patchcord 
terminates.

Port ID-1 (SW provisioning view subtab only) Displays the port ID.

Port label-1 Displays the name of the port.

Attenuator When indicated, this is the product ID of the bulk attenuator to be equipped on this 
connection. It also reports when an internal attenuator must be placed between the 
DC-TX and DC-RX ports on the preamplifier (when no DCU is equipped).

Position-2 Displays the rack, shelf, and slot position of the card where the patchcord 
terminates.

Unit-2 Displays the name of the card.

Port Num (SW provisioning view subtab only) Displays the port number where the patchcord 
terminates.

Port ID-2 (SW provisioning view subtab only) Displays the port ID.

Port Label-2 Displays the name of the port.

P/F Displays whether the connection relates to a present or forecast circuit.
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Figure 2-26 Query Dialog 

Step 4 To perform a query using individual parameters, select the desired parameters from the drop-down lists 
in the Query Definition area. The selected parameters appear in the Query Preview area at the bottom of 
the screen. Table 2-13 describes the fields in the Query Dialog.

Table 2-13 Query Dialog Fields 

Column Label Description

Group Allows you to filter the report to include only the data in the selected group. You 
can also view groups in the Project Explorer view under the network folder.

Demand Allows you to filter the report to include only the data in the selected demand. 
The demand field is available only when you select a specific traffic group.

DWDM Card Type Allows you to filter the report to include only the data in the selected DWDM 
card type. 

Source Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific source site.

Destination Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific destination site.

Wavelength Allows you to filter the report to include only services using the specified 
wavelength.

Alarm Allows you to filter the report to include only services flagged with a green, 
yellow, orange, or red indicator.

P/F Allows you to filter the report to include only present services, only forecast 
services, or both.

Virtual Allows you to filter the report to include or exclude virtual channels in the 
Optical Results Table.
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Step 5 Choose one of the following, as needed:

 • Click Run Query. The window closes, and the query results appear in the Traffic Matrix tab 
(Figure 2-27). The parameters of the query appear in the horizontal area just below the button bar.

 • Click Reset Query to clear your selections in the Query Dialog. 

 • Click Close to close the window without running a query.

Figure 2-27 Traffic Matrix Tab

Each row in the tab shows the performance of one optical path. Table 2-18 describes the information in 
the columns. The Traffic Matrix report displays separate rows for the TX and RX direction of the optical 
channels.

Table 2-14 Traffic Matrix Tab Columns 

Column Label Description

Group Categorizes each demand type (Point-to-Point, P-ring, and ROADM). Click the 
plus (+) sign by a demand type to expand and show the optical channels.

Serv. Circuit Displays the optical channel label; for example, Site1-Site2.

Source Displays the site name for the optical channel source.

Source Position Displays the rack, shelf, and slot identifiers for the source of the optical channel. 
The format of the field is Rack.Shelf.Slot.

Source Unit Displays the product ID for the optical channel source.

Source Port Displays the port for the source of the optical channel; for example, Client RX.

Destination Side Displays the site name for the optical channel destination.

Destination 
Position

Displays the rack, shelf, and slot identifiers for the destination of the optical 
channel. The format of the field is Rack.Shelf.Slot.

Destination Unit Displays the product ID for the optical channel destination.

Destination Port Displays the port for the destination of the optical channel; for example, Client 
TX.

Cl. Serv. Type Displays the client service type of the demand; for example, OC-48.

Protection Displays the protection type of the demand; for example, P-ring or Y-cable.

Wavelength Displays the wavelength of the optical channel.
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Step 6 To close the Traffic Matrix report, click the X in the upper right corner of the tab.

2.5.6  Displaying the Layout 
Use the following procedure to view a graphical representation of each site in an analyzed network: 

Step 1 Complete one of the following:

 • To view the Layout report for a network, click the Networks Mgmt Tree tab and click the network.

 • To view the Layout report for a site, click the NtView Net# tab and click the site.

Step 2 In the Tasks Pane, click Layout. The Layout tab appears (Figure 2-28). 

Opt Bypass Identifies where the optical channel is dropped and reinserted when it is not 
terminated on a TXP or MXP card (optical bypass). If “none” appears in the Op 
Bypass column, no optical bypass is defined for the optical channel.

DWDM Interface 
Type

Identifies the DWDM interface type that is used for the optical channel:

 • Transponder indicates that an MSTP transponder, an MSTP muxponder, or a 
DWDM pluggable port module is used for the optical channel.

 • Line Card indicates that an ITU line card is used for the optical channel.

DWDM Card Type Identifies the type of transponder or line card used for the optical channel.

Table 2-14 Traffic Matrix Tab Columns (continued)

Column Label Description
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Figure 2-28 Layout Report (Rack View)

Step 3 From the Site drop-down list, choose the site in the network to display in the layout report.

Step 4 In the tree view on the left of the tab, right-click a rack and choose Expand to view a list of all shelves 
and cards in the rack. 

Step 5 Click the desired rack or shelf to view it in the layout graphic. Figure 2-29 displays the shelf view.
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Figure 2-29 Layout Report (Shelf View)

Step 6 To view details about a card, double-click the card. The Details dialog box opens with client information:

 • Label—Displays the name of the card.

 • Product ID—Displays the product ID of the card.

 • Service Category—Future use.

 • Description—Provides a brief description of the card functionality.

 • Price—Lists the price for the card based on the price list selected during project creation.

 • ITU Channel—Identifies the ITU channel wavelength for the card.

Click Close to close the Details dialog box.

Step 7 To filter the layout display, choose one of the following from the drop-down list:

 • Any—Displays all cards for both the present and forecast traffic demand.

 • Present—Displays cards for only the present traffic demand.

 • Locked & Unlocked—Highlights the locked and unlocked cards in the layout.

 • Alarmed—Highlights the alarmed cards in the layout.

Step 8 After network analysis, all items are in locked mode. To unlock cards so that Cisco MetroPlanner can 
rearrange the layout to optimize slot usage during network analysis, right-click locked card in the rack 
tree and choose Unlock.
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Step 9 To export the graphical representation of the layout in JPEG format, click Export. In the Layout export 
dialog box, type the name of the file and navigate to the desired folder. Click Save.

Step 10 To zoom the layout graphic in or out, click the Zoom In and Zoom Out icons. For more information about 
the Cisco MetroPlanner icons, see Appendix A, “GUI Information and Shortcuts.”

Step 11 To close the Layout report, click the X in the upper right corner of the tab.

2.5.7  Viewing the Link Availability Report
Cisco MetroPlanner determines link availability based on circuit failure rate and time to repair. Use the 
following procedure to view the Link Availability report:

Step 1 Complete one of the following:

 • To view the Link Availability report for a network, click the Networks Mgmt Tree tab and click the 
network.

 • To view the Link Availability report for a site, click the NtView Net# tab and click the site.

Step 2 In the Tasks Pane, click Link Availability. The Link Availability tab appears.

Step 3 Click New Query to open the Query Dialog (Figure 2-26 on page 2-44). The Query Dialog allows you 
to filter the optical results using a variety of parameters and templates.

Step 4 To perform a query using individual parameters, select the desired parameters from the drop-down lists 
in the Query Definition area. The selected parameters appear in the Query Preview area at the bottom of 
the screen. Table 2-15 describes the fields in the Query Dialog.

Table 2-15 Query Dialog Fields 

Column Label Description

Group Allows you to filter the report to include only the data in the selected group. You 
can also view groups in the Project Explorer view under the network folder.

Demand Allows you to filter the report to include only the data in the selected demand. 
The demand field is available only when you select a specific traffic group.

DWDM Card Type Allows you to filter the report to include only the data in the selected DWDM 
card type. 

Source Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific source site.

Destination Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific destination site.

Wavelength Allows you to filter the report to include only services using the specified 
wavelength.

Alarm Allows you to filter the report to include only services flagged with a green, 
yellow, orange, or red indicator.

P/F Allows you to filter the report to include only present services, only forecast 
services, or both.

Virtual Allows you to filter the report to include or exclude virtual channels in the 
Optical Results Table.
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Step 5 Choose one of the following, as needed:

 • Click Run Query. The window closes, and the query results appear in the Link Availability tab 
(Figure 2-30). The parameters of the query appear in the horizontal area just below the button bar.

 • Click Reset Query to clear your selections in the Query Dialog. 

 • Click Close to close the window without running a query.

Figure 2-30 Link Availability Report

Each row in the tab shows the performance of one optical path. Table 2-16 describes the information in 
the columns.

Step 6 To close the Link Availability report, click the X in the upper right corner of the tab.

Table 2-16 Link Availability Tab Columns 

Column Label Description

Group Categorizes each demand type (Point-to-Point, P-ring, and ROADM). Click the 
plus (+) sign by a demand type to expand and show the optical channels.

Serv. Circuit Displays the optical channel label; for example, Site1-Site2.

P/F Identifies whether the channel is present and forecast (P/F) or forecast (F).

DWDM Card Type Identifies the type of transponder or line card used for the optical channel.

Protection Displays the protection type of the demand; for example, P-ring or Y-cable.

Cl. Serv. Type Displays the client service type of the demand; for example, OC-48.

Source Displays the site name for the optical channel source.

Destination Displays the site name for the optical channel destination.

L.A. (% Complete) Displays the link availability percentage. Link availability is calculated based on 
the failure rate and time to repair. 
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2.5.8  Viewing Optical Results
Use the following procedure to view the optical results of the network that you created and analyzed:

Step 1 Complete one of the following:

 • To view the Optical Results report for a network, click the Networks Mgmt Tree tab and click the 
network.

 • To view the Optical Results report for a site, click the NtView Net# tab and click the site.

Step 2 In the Tasks Pane, click Optical Results. The Optical Results tab appears.

Step 3 Click New Query to open the Query Dialog (Figure 2-26 on page 2-44). The Query Dialog allows you 
to filter the optical results using a variety of parameters and templates.

Step 4 To perform a query using individual parameters, select the desired parameters from the drop-down lists 
in the Query Definition area. The selected parameters appear in the Query Preview area at the bottom of 
the screen. Table 2-17 describes the fields in the Query Dialog.

Step 5 Choose one of the following, as needed:

 • Click Run Query. The window closes, and the query results appear in the Optical Results tab 
(Figure 2-31). The parameters of the query appear in the horizontal area just below the button bar.

 • Click Reset Query to clear your selections in the Query Dialog. 

 • Click Close to close the window without running a query.

Table 2-17 Query Dialog Fields 

Column Label Description

Group Allows you to filter the report to include only the data in the selected group. You 
can also view groups in the Project Explorer view under the network folder.

Demand Allows you to filter the report to include only the data in the selected demand. 
The demand field is available only when you select a specific traffic group.

DWDM Card Type Allows you to filter the report to include only the data in the selected DWDM 
card type. 

Source Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific source site.

Destination Allows you to filter the report to include only the results of incoming/outgoing 
services to or from a specific destination site.

Wavelength Allows you to filter the report to include only services using the specified 
wavelength.

Alarm Allows you to filter the report to include only services flagged with a green, 
yellow, orange, or red indicator.

P/F Allows you to filter the report to include only present services, only forecast 
services, or both.

Virtual Allows you to filter the report to include or exclude virtual channels in the 
Optical Results Table.
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Figure 2-31 Optical Results Tab

Each row in the tab shows the performance of one optical path. Table 2-18 describes the information in 
the columns.

Table 2-18 Optical Results Tab Columns 

Column Label Description

Name Displays the identification number automatically given to each path in the order 
that the channels were entered into the design.

Group Identifies the demand group for the optical channel.

Protect Displays the protection type of the channel. For a protected channel, both paths 
are shown. The path leaving the east side of the source is shown first.

SOL Displays the results of the start of life analysis. The indicator shows the optical 
performance for the path. Green indicates success, yellow indicates success with 
a marginal failure risk (between 0 and 16 percent), orange indicates that the 
channel has a higher risk of failure (between 16 and 50 percent), and red indicates 
failure. 

EOL Displays the end of life analysis. The indicator shows the optical performance for 
the path at the end of the fiber’s life. Green indicates success, yellow indicates 
success with a marginal failure risk (between 0 and 16 percent), orange indicates 
that the channel has a higher risk of failure (between 16 and 50 percent), and red 
indicates failure.

SE Displays an indicator to identify if a system error or untested configuration 
prevents the connection from working properly. Green indicates no errors and red 
indicates failure.

Wavelength Displays the assigned wavelength of the optical path.

P/F Displays the present/forecast services indication.

Source Displays the name of the source site and source interface; for example, Site 1-E.

Destination Displays the name of the destination site.

Span (km) Displays the total span length (source -> destination) for this path in kilometers.

Tx Type Displays the type of transceiver.
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Step 6 To close the Optical Results report, click the X in the upper right corner of the tab.

BER target Displays the bit error rate (BER) target for this channel based on the capability 
of the channel’s optical interface. It is 1.0E-15 for the interfaces using forward 
error correction (FEC) and 1.0E-12 for interfaces without FEC.

SOL OSNR (dB) Displays the start of life average optical signal-to-noise ratio (OSNR) value at the 
receiver. OSNR refers to the selected resolution bandwidth (RBW) bandwidth.

EOL OSNR (dB) Displays the end of life average OSNR value at the receiver. OSNR refers to the 
selected RBW bandwidth.

SOL OSNR Margin 
(dB)

Displays the SOL OSNR margin calculation, which is the difference between the 
OSNR value at a certain power of the working point of the receiver client and the 
working area boundary.

EOL OSNR Margin 
(dB)

Displays the EOL OSNR margin calculation, , which is the difference between 
the OSNR value at a certain power of the working point of the receiver client and 
the working area boundary.

SOL RX (dBm) Displays the SOL received average power at the destination site in dBm.

EOL RX (dBm) Displays the EOL received average power at the destination site in dBm.

SOL Power margin 
(dB)

Displays the SOL power budget margin at the receiver in decibels. It is defined 
as the offset between the receiver working point and the BER curve with margin. 
A positive value indicates no power problems.

EOL Power margin 
(dB)

Displays the EOL power budget margin at the receiver in decibels. It is defined 
as the offset between the receiver working point and the BER curve with margin. 
A positive value indicates no power problems.

SOL Overload (dB) Displays the SOL overload margin at the receiver in decibels. A positive value 
indicates no overload problems.

EOL Overload (dB) Displays the EOL overload margin at the receiver in decibels. A positive value 
indicates no overload problems.

RX atten Displays the attenuation at the input of the receiver.

PMD (ps) Displays the calculated total PMD for each circuit. If the overall PMD for the link 
overcomes the maximum allowed, the PMD value is colored red. The maximum 
allowed value depends on the client interface. For these special cases, the 
network must be manually resolved by contacting a Cisco optical sales engineer.

Latency Displays the latency time for the current circuit. 

Chr. Disp. check Displays the status of the chromatic dispersion check. Green indicates that the 
dispersion check passed. Red indicates that the dispersion check failed.

Table 2-18 Optical Results Tab Columns (continued)

Column Label Description
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2.5.9  Viewing Wavelength Routing
Use the following procedure to view the wavelength routing map for an analyzed network:

Step 1 Click the Networks Mgmt Tree tab, and click the analyzed network.

Step 2 In the Tasks Pane, click Wavelength Routing. The Wavelength Routing tab appears (Figure 2-32).

Figure 2-32 Wavelength Routing Tab 

Step 3 Choose one of the following from the drop-down list: Any (to view both forecast and present routing), 
Present (to view only the present routing), or Forecast (to view only the forecast routing).
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Table 2-19 describes the information in the columns.

Step 4 To export the graphical representation of the layout in JPEG format, click Export. In the Wavelength 
Routing export dialog box, type the name of the file and navigate to the desired folder. Click Save.

Step 5 To close the Wavelength Routing report, click the X in the upper right corner of the window.

2.5.10  Viewing Report Differences
You can compare the BoM, Internal Connections, and Installation Parameters reports for two networks. 
This is useful to see the differences between a baseline network and an Install or Upgrade network. 

 • The BoM Diff report lists the units that were added and/or removed from the BoM.

 • The Internal Connection Diff report lists changed connections. If at least one of the two end points 
of an internal connection is different, Cisco MetroPlanner reports that the internal connection has 
changed. The report shows all internal connections that were present in the baseline network but are 
not present in the final network, and all internal connections not present in the baseline network but 
present in the final network.

 • The Installation Parameters Diff report lists changed parameters between the baseline network and 
the final network.

Use the following procedure to compare networks:

Step 1 Click the Reports Diff icon. For more information about Cisco MetroPlanner icons, see Appendix A, 
“GUI Information and Shortcuts.” The Reports Diff dialog box appears . Figure 2-33 shows the Reports 
Diff dialog box as it appears when at least two analyzed networks exist in a project. 

Table 2-19 Wavelength Routing Tab Columns 

Column Label Description

wl Lists the wavelengths supported by the platform. 

Site # Represents a site in the network.

Duct # Represents a duct in the network.

W Represents the west side of a site.

E Represents the east side of a site.

Couple Represents a pair of fibers at a site.
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Figure 2-33 Reports Diff Dialog Box

Step 2 In the Compare networks area, choose the baseline network from the drop-down list on the left. Choose 
the network to compare from the drop-down list on the right. 

Step 3 Click the report you would like to view. If you chose one non-analyzed network, you can view only the 
Bill of Material differences report.

 • Bill of Material—(Figure 2-34 on page 2-57) For a description of the columns, see Table 2-20 on 
page 2-58.

 • Installation Parameters—(Figure 2-35 on page 2-59) For a description of the columns, see 
Table 2-21 on page 2-59.

 • Internal Connections—(Figure 2-36 on page 2-60) For a description of the columns, see Table 2-22 
on page 2-61.

Step 4 Click Ok. 

Figure 2-34 shows the BoM Diff report. 
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Figure 2-34 BOM Diff Report 

The upper section of the BoM Diff Report tab displays the following information for each network:

 • BoM total discounted—Displays the price for the overall network (without spare parts) for each item 
in the BoM. If Use global discount is checked, the total includes the discount from the Global 
discount percentage field.

 • Spare total discounted—Displays the price for all of the recommended spare parts in all of the 
maintenance centers for the overall network. It is the sum of each spare item using the discounted 
price. The total appears after you check the Spare Part Report check box.

 • BoM + Spare total discounted—Displays the sum of the BoM total discounted price and spare total 
discounted price.

 • Price List—Displays the name of the price list database selected for the project.

 • Price List last update—Displays the date that the selected price list was last updated.

 • Currency—Displays the value of the currency used for each of the price values as specified within 
the selected price list database.

Table 2-20 describes the information in the BoM Diff report columns. Click a column to sort the table 
information by that column.
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Figure 2-35 shows the Installation Parameters Diff report.

Table 2-20 BoM Diff Report Columns

Column Label Description

Name Displays the name of the equipment.

(Diff Summary) Indicates a difference exists between the two network BoMs:

= (equal sign)—Indicates that no difference exists between the two 
networks.

 (crossed-out equal sign)—Indicates that the item is present on 
both networks, but the number per network is different.

1—Indicates that this item is present in the first network but not in the 
second network.

2—Indicates that this item is present in the second network but not in 
the first network.

PID Displays the ID string of the product.

Quantity Displays the number of specific products in the BoM. If the networks 
have a different quantity, Cisco MetroPlanner displays both numbers 
in red in the following format: first network Quantity/second network 
Quantity.

Unit Price Displays the price for each unit. 

Total Price Displays the total price of the products before applying the discount. 
If the networks have a different quantity, Cisco MetroPlanner displays 
both numbers in red in the following format: first network Total 
Price/second network Total Price.

Discounted Total Price Displays the total price of the products after applying the discount. If 
the networks have a different quantity, Cisco MetroPlanner displays 
both numbers in red in the following format: first network Discounted 
Total Price/second network Discounted Total Price.
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Figure 2-35 Installation Parameters Diff Report 

Table 2-21 describes the columns on Installation Parameters Diff report. Click a column to sort the table 
information by that column.

Differences between networks appear in red and in the following format: baseline network value/final 
network value.

Table 2-21 Installation Parameters Diff Report Columns 

Category Description

Name Displays the name of the site. 

(Diff Summary) Indicates a difference exists between the two network BoMs:

= (equal sign)—Indicates that no difference exists between the two networks.

 (crossed-out equal sign)—Indicates that the item is present on both networks, 
but the number per network is different.

1—Indicates that this item is present in the first network but not in the second 
network.

2—Indicates that this item is present in the second network but not in the first 
network.

Side Displays the node interface: T (terminal), E (east), or W (west).

Position Displays the rack, shelf, and slot position of the card from which the patchcord 
originates.

Unit Displays the name of the card.

Port # Displays the port number from which the patchcord originates.

Port ID Displays the port ID.

Port Label Displays the name of the port.

Parameter Displays the name of the parameter to be set, such as RX Power Low.

Value Displays the name of the value to be set.
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Figure 2-25 shows the Internal Connections Diff report.

Figure 2-36 Internal Connections Diff Report

Table 2-22 lists the columns in the Internal Connections Diff report and their descriptions. Click a 
column to sort the table information by that column. 

Differences between networks appear in red and in the following format: baseline network value/final 
network value.

Measurement 
Unit

Displays the measurement unit for the related installation parameter value, such as 
dBm.

Manual Set Indicates with a Yes or No which parameters must be manually set using the CTC 
interface.

Table 2-21 Installation Parameters Diff Report Columns (continued)

Category Description
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2.6  Editing a Project
Cisco MetroPlanner allows you to edit the a project either before or after network analysis. Error 
messages that occur during network analysis often cannot be resolved until you edit one or more network 
components.

To complete the procedures in this section, you must have a project open and the network(s) loaded. See 
the “2.1.1  Opening a Project” section on page 2-3 and the “2.1.2  Loading and Unloading Networks” 
section on page 2-3.

Table 2-22 Internal Connections Tab Columns 

Column Name Description

Name Displays the name of the site. On the SW provisioning view subtab, this column 
indicates whether the connection should be manually set using the CTC interface or 
removed.

(Diff Summary) Indicates a difference exists between the two network BoMs:

= (equal sign)—Indicates that no difference exists between the two networks.

 (crossed-out equal sign)—Indicates that the item is present on both networks, 
but the number per network is different.

1—Indicates that this item is present in the first network but not in the second 
network.

2—Indicates that this item is present in the second network but not in the first 
network.

Position Displays the rack, shelf, and slot position of the card from which the patchcord 
originates.

Unit Displays the name of the card.

Port label Displays the name of the port.

Attenuator When indicated, this is the product ID of the bulk attenuator to be equipped on this 
connection. It also reports when an internal attenuator must be placed between the 
DC-TX and DC-RX ports on the preamplifier (when no DCU is equipped).

Position Displays the rack, shelf, and slot position of the card where the patchcord 
terminates.

Unit Displays the name of the card.

Port Label Displays the name of the port.

P/F Displays whether the connection relates to a present (P/F) or forecast (F) circuit.
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2.6.1  Editing Project Parameters
Use the following procedure to edit project parameters:

Step 1 Click Project in the Project Explorer.

Step 2 In the Properties pane, complete the following as needed:

 • Customer—Type the name of the customer (128 character maximum) requiring this network design. 

 • Created by—Type the user name (128 character maximum).

 • Units—Choose the span measurement unit: Km (kilometers) or Miles.

 • Price List—Choose the price database from the drop-down list.

 • Layout—Choose ANSI (the North American standard) or ETSI (the international standard) from 
the drop-down list to indicate the platform type. ANSI networks will not allow you to define SDH 
(ETSI) service demands. ETSI networks will not allow you to define SONET (ANSI) service 
demands. 

2.6.2  Editing Network Parameters
Use the following procedure to edit network parameters:

Step 1 Click a network in the Project Explorer or Networks Mgmt Tree.

Step 2 In the Properties pane, complete the following as needed:

 • Name—Type the network name (128 character maximum).

 • Position—Type the object location in pixels. 

 • Created by—Type the user name (128 character maximum).

 • Status—Displays the state of the network (Design, Design-Analyzed, Install, etc.).

 • Use Bundles—Check to use the Multishelf Management Integrated Kit bundle when generating the 
BoM instead of the single items.

 • Use Maintenance Center—Check to determine the spare parts required by the network. If the 
network is in the Upgrade state, the parts required to support the implemented services and the 
newly added present services are included. To generate a spare parts report, you must associate the 
sites in a network with a maintenance center before network analysis. 

 • Use Global Discount—Check to use the global discount for the entire network. The global discount 
is applied to all components in the BoM.

 • Global Discount—Enter a new global discount in the form of a percentage.

 • Include SW Licenses—Check to include software licenses in the BoM.

 • Include Paper Documentation—Check to include paper documentation in the BoM.

 • Include CD Documentation—Check to include CD documentation in the BoM.

 • Hide Bom/price discount—Check to hide the global discount in the Unit Price column of the BoM.

 • Dimension—Type the network size in pixels.

 • Background color—Click to choose a color for the network background.
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 • Background image—Displays the JPEG or GIF filename used as a background, if any. To choose a 
JPEG or GIF file as a background graphic for the network, click the down arrow and navigate to the 
desired directory. 

2.6.3  Editing Site Parameters
Editing the site parameters allows you to make changes to the current site configuration. A site folder in 
the Project Explorer displays the interface node information. Figure 2-37 shows a site in the Project 
Explorer before network analysis. 

Figure 2-37 Site in the Project Explorer

A site folder for an analyzed network design also contains the following items, many of which you can 
edit:

 • E, W, T—For a Line or Line+ site, two interface nodes appear in the Project Explorer under the Site 
folder, labeled W (West) and E (East). For a Terminal or Terminal+ site, only one interface node (T) 
appears. 

 • C-Band or L-Band—Displays the supported band for the side (E, W, or T interface). 

 • Amplifiers—Lists the amplifiers and all related cards for each band and for each side (E, W, or T 
interface). 

 • Add/Drop—Displays all of the add/drop and related cards for the band and side (E, W, or T 
interface).

 • Site Type Parameters—When selected, shows the site functionality and type in the Properties pane.

 • Band Parameters—When selected, shows the output power in the Properties pane.

 • Client—Lists the client cards. 

Use the following procedure to edit site parameters:

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu. 

Step 2 Click the desired Site folder. The site parameters appear in the Properties pane.

Step 3 Complete the following to modify the site parameters in the Properties pane, as needed:

 • Label—(Display only) Displays the site label, such as Site 1.

 • Name—Enter the desired site name.

 • Position—Enter the desired site pixel position; for example, an entry of 0,0 positions the Site icon 
in the upper left corner of the NtView Net# tab. 
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 • Topology—Choose the topology type from the drop-down list: 

 – Line—Two pairs of fibers are terminated at the node.

 – Terminal—A single pair of fibers is terminated at the node.

 – Line+—Two pairs of fibers are terminated at the node but the number of fibers can be increased 
if an MMU card (topology upgrade) is installed.

 – Terminal+—A single pair of fibers is terminated at the node but the number of fibers can be 
increased in if an MMU card (topology upgrade) is installed.

 • Maintenance Center—Choose the name of the maintenance center from the drop-down list. To 
create a maintenance center, see the “2.6.5  Creating a Maintenance Center” section on page 2-67.

 • IP Address—Type the IP address of the node.

 • Shelf Config—Choose the shelf configuration type from the drop-down list: 

 – Multi Shelf Integrated Switch—A multishelf node configuration using an Ethernet Adapter 
Panel (EAP).

 – Multi Shelf External Switch—A multishelf node configuration using a Cisco Catalyst 2950.

 – Individual Shelf—A node in single-shelf mode.

 • Node Protection—Choose the node protection type from the drop-down list: Same Shelf or 
Separated Shelves. 

 • DCC Chain—When checked, indicates that a TXP(P)_MR_2.5G card is in Slot 12 on each shelf at 
each site. 

 • Osmine Layout Compliance—When checked, indicates that all the nodes in the network design have 
transponder and line cards compliant with OSMINE.

 • Hybrid Layout—When checked, indicates that all the nodes are configured as hybrid MSTP/MSPP 
nodes.

 • Max Shelf Num—Choose the maximum number (from 1 to 4) of ANSI or ETSI shelves (that equip 
optical cards or transponder/muxponder [TXP/MXP] cards) that can be placed in each rack in the 
site when generating the site layout. 

 • Functionality—Choose the site functionality from the drop-down list. Table 2-23 summarizes the 
site design rules. The site icon changes depending on the functionality. For a description of the site 
icons, see Appendix A, “GUI Information and Shortcuts.”

 – Auto—Allows the highest degree of flexibility in creating the network. Cisco MetroPlanner 
generates a design for the site with the lowest possible cost given the other constraints.

 – Pass Through—Indicates that no equipment will be located at this site.

 – Line amplifier—Prevents any add/drop traffic at this site.

 – OSC site—Indicates that site is designated for network communication, providing the 
possibility to access the optical service channel (OSC) for management of the MSTP network. 
By default, no amplifiers are included in this site. However, if Cisco MetroPlanner determines 
that an amplifier is required in the network, it can automatically place it at this location. 
Cisco MetroPlanner allows you to set (force) preamplifier and booster amplifiers for each 
direction on a OSC Site node.

 – Add/Drop—Indicates that this site has add/drop capability. Only point-to-point and P-ring 
circuits can be added/dropped at this site.

 – Hub—Indicates that this site is equipped with filters for adding and dropping all the channels 
(on both West and East sides). All express paths are open in hub configurations.
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 – Gain equalizer—Indicates that this site uses WSS cards to control the generated tilt and extend 
unregenerated distances. The site is realized as an ROADM site without demultiplexer cards.

 – R-OADM—Indicates that this site supports Any-to-Any and also Fixed (point-to-point and 
P-ring) traffic types.

 • Type—Choose the site type from the drop-down list (see Table 2-23):

 – Auto—Allows the highest degree of flexibility in creating the network. Cisco MetroPlanner 
generates a design for the site with the lowest possible cost given the other set of constraints.

 – Glass Through—Indicates a low-priority amplification site.

 – Line—Indicates a high-priority amplification site.

 – OADM—Indicates that it is a site with add/drop channels using discrete channel filters (1, 2, 
4-ch 1, 4-band).

 – WSS—Indicates that it is a site equipped with 32DMX or 32DMX-O.

 – Mux/Demux—Indicates that this is a full multiplexer/demultiplexer (FMD) site that adds and 
drops all 32MUX-O and 32DMX-O channels on both sides.

 • Anti ASE—Choose Yes to configure the site so that all the express channels on the site are optically 
dropped and reinserted. In addition, all the patchcords between the West and East sections are 
removed. Choose Auto to allow Cisco MetroPlanner to decide if the site should be configured as 
anti-amplified spontaneous emissions (Anti-ASE). See Table 2-23 for a summary of the site design 
rules.

Table 2-23 Site Design Rules 

Topology Functionality Type Card Options

C-Band 
32/16 Ch. 
100 GHz

C-Band 
8 Ch. 
100 GHz

C-Band 
64 Ch. 
50 GHz

L-Band 
32 Ch. 
100 GHz

Line Pass Through — — Yes Yes Yes Yes

Line amplifier Line amplifier In line at 1 Yes Yes Yes Yes

Glass Through — Yes Yes Yes Yes

OSC Site — — Yes Yes Yes Yes

Add/Drop OADM 
(Anti-ASE)

OADM cards Yes Yes No No

Mux/Demux — Yes Yes No No

Hub Mux/Demux — Yes Yes No No

WSS 32DMX-O Yes Yes Yes No

32DMX Yes Yes Yes Yes

Gain equalizer WSS 32DMX Yes No Yes Yes

ROADM WSS 32DMX-O Yes No Yes No

32DMX Yes No Yes Yes

Line+ ROADM WSS 32DMX-O Yes No No No

32DMX Yes No No Yes

Hub WSS 32DMX-O Yes No No No

32DMX Yes No No Yes
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Step 4 To modify the band parameters, click C-Band or L-Band in the Project Explorer for the desired site 
interface. In the Properties pane, enter the desired Output power.

Step 5 To modify amplifier parameters, click C-Band Amplifiers or L-Band Amplifiers in the Project 
Explorer for the desired site interface. 

a. In the Properties pane From Fibre area, complete the following as needed:

 • PRE—Choose the desired preamplifier from the drop-down list (None, Auto, or OPT-PRE).

 • DCU 1/2—Choose the desired DCU from the drop-down lists.

 • Attenuator—Choose the desired attenuator from the drop-down list.

 • Output power—Enter the desired output power.

 • Tilt—Enter the desired tilt value.

b. In the Properties pane To Fibre area, complete the following as needed:

 • BST—Choose the desired booster from the drop-down list (None, Auto, OPT-BST, or 
OPT-BST-E).

 • Output power—Enter the desired output power.

 • Tilt—Enter the desired tilt value.

c. In the Properties pane General area, choose the OSC from the drop-down list (OSC-CSM or 
OSCM).

Step 6 To modify OADM parameters, click Add/Drop in the Project Explorer for the desired site interface. In 
the Properties pane, complete the following as needed:

 • In the Line/OADM area, choose the desired attenuator from the drop-down list.

 • In the Mux/Demux WSS area, complete the following as needed:

 – Patch Panel—Choose the patch panel from this drop-down list.

 – Demux—Choose the demultiplexer from this drop-down list.

 – Mux—Choose the multiplexer from this drop-down list.

Terminal Add/Drop OADM-xc

(Anti-ASE)

OADM cards Yes Yes No No

Mux/Demux — Yes Yes No No

ROADM WSS 32DMX-O Yes Yes Yes No

32DMX Yes Yes Yes Yes

Terminal+ ROADM WSS 32DMX-O Yes No No No

32DMX Yes No No Yes

Table 2-23 Site Design Rules (continued)

Topology Functionality Type Card Options

C-Band 
32/16 Ch. 
100 GHz

C-Band 
8 Ch. 
100 GHz

C-Band 
64 Ch. 
50 GHz

L-Band 
32 Ch. 
100 GHz
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2.6.4  Deleting a Site
Use the following procedure to delete an existing site from the network design:

Step 1 Delete any traffic demands used by the site. See the “2.6.9  Deleting a Traffic Demand” section on 
page 2-71.

Step 2 Right-click the site in the NtView Net# tab and choose Delete from the shortcut menu. As an alternative, 
you can click Delete in the Tasks Pane. A confirmation message appears, asking you to confirm the 
deletion of the site.

Step 3 Click Yes to delete the site. 

2.6.5  Creating a Maintenance Center
Use the following procedure to add maintenance centers that will supply your network with spare parts 
in the event of a failure. This feature helps your customer determine the quantity of spares that should 
be purchased, depending on the number of maintenance centers and their availability. Maintenance 
centers appear in the Maintenance Center folder under a site in the Project Explorer.

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 Scroll down the Project Explorer, right-click the Maintenance Center folder, and choose New 
Maintenance Center from the shortcut menu. 

Step 3 Highlight the new maintenance center in the Project Explorer.

Step 4 In the Properties pane, complete the following as needed:

 • Availability percentage—Choose the percentage that represents the required confidence level for 
finding needed spare parts in the maintenance center: 50, 75, 95, or 99 percent. 

 • Mean repair time—Enter the time (including transportation) required to restock the part in the 
maintenance center.

Step 5 To associate a maintenance center with a site, see the “2.6.3  Editing Site Parameters” section on 
page 2-63.

2.6.6  Editing a Point-to-Point Demand
Use the following procedure to edit a point-to-point demand:

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 In the Project Explorer, right-click the point-to-point demand and choose Edit from the shortcut menu. 
The Edit Point to Point Demand dialog box appears (Figure 2-38). 
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Figure 2-38 Edit Point to Point Demand Dialog Box

Step 3 To modify the information for each channel, complete the following as needed:

 • Forecast—Check to change a present channel to a forecast channels. 

 • Srv. Type—Choose the desired service type from the drop-down list. Changing the service type for 
one channel automatically changes the service type for all channels.

 • Protection—Choose the desired protection type from the drop-down list. Changing the protection 
type for one channel automatically changes the protection for all channels.

 • Path—Choose W (west-to-east) or E (east-to-west) from the drop-down list.

 • Wavelength—Choose the desired wavelength type from the drop-down list. If you choose Auto, 
Cisco MetroPlanner assigns wavelength to the channels with the lowest possible cost given the other 
constraints.

 • Optical Bypass—Choose the site for optical bypass from the drop-down menu.

 • WDM Intf. Type—Choose the desired card interface type from the drop-down list. 

 • WDM Card Type—Choose the desired card type from the drop-down list. The available options 
depend on the card interface type that is selected. Changing the card type for one channel 
automatically changes the card type for all channels.

 • Src. Client Intf.—Choose the desired source client interface from the drop-down list. The available 
options depend on the card type that is selected.

 • Dst. Client Intf.—Choose the desired destination client interface from the drop-down list. The 
available options depend on the card type that is selected.

Step 4 To add a new channel, click the Create a new circuit icon on the right of the Edit Point to Point Demand 
dialog box. A new row appears. Repeat Step 3 as needed to complete the parameters for the new channel.

Step 5 To delete an existing channel, select the row and click the Remove the selected circuit icon on the right 
of the Edit Point to Point Demand dialog box.

Step 6 Click Ok to save the changes to the channels and close the Edit Point to Point Demand dialog box, or Cancel 
to close the dialog box without saving the changes. 

2.6.7  Editing a P-Ring Demand
Use the following procedure to change the distribution of services in a P-ring service demand:

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.
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Step 2 In the Project Explorer, right-click the P-ring demand and choose Edit from the shortcut menu. The Edit 
P-Ring Demand dialog box appears (Figure 2-39). 

Figure 2-39 Edit P-Ring Demand Dialog Box

Step 3 Complete the following as needed in the Edit P-Ring Demand dialog box to modify the P-ring:

 • Service Type—Choose the desired service type from the drop-down list. 

 • WDM Card Type—Choose the desired card type from the drop-down list. The available options 
depend on the service type selected. 

 • WDM Interface—Choose the desired card interface type from the drop-down list. The available 
options depend on the card type selected.

In the Circuits area of the Edit P-Ring Demand dialog box, complete the following as needed:

 • Ring—(Display only) Displays the name of the P-ring.

 • Forecast—Check to change the present channels to forecast channels. 

 • Wavelength—Choose the desired wavelength type from the drop-down list. If you choose Auto, 
Cisco MetroPlanner assigns wavelengths to the channels with the lowest possible cost given the 
other constraints.

In the Sections area of the Edit P-Ring Demand dialog box, complete the following as needed:

 • Src—(Display only) Displays the source site name for a section.

 • Dst—(Display only) Displays the destination site name for a section.

 • Opt. Bypass—Choose the sites from the drop-down list where the channels for the current demand 
will be optically dropped. Only the sites between the source and destination sites along the path of 
this section are available as options. 

 • Src. Client Intf.—Choose the desired source client interface from the drop-down list. The available 
options depend on the card type selected.

 • Dst. Client Intf.—Choose the desired destination client interface from the drop-down list. The 
available options depend on the card type selected.

Step 4 To add a new P-ring channel, click the Create a new P-Ring circuit icon on the left of the Edit Point to 
Point Demand dialog box. A new row appears. Repeat Step 3 as needed to complete the parameters for 
the new P-Ring.
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Step 5 To delete an existing channel from the P-ring, select the row and click the Remove the selected P-Ring 
circuit icon on the left of the Edit P-Ring Demand dialog box.

Step 6 Click Ok to save the changes to the channels and close the Edit P-Ring Demand dialog box, or Cancel to 
close the dialog box without saving the changes.

2.6.8  Editing a ROADM Demand
Use the following procedure to change the distribution of services in a ROADM service demand:

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 Right-click the ROADM traffic group and choose Edit from the shortcut menu. The Edit ROADM 
Demand dialog box appears (Figure 2-40).

Figure 2-40 Edit ROADM Demand Dialog Box

Step 3 Select a traffic pattern type (Hub or Meshed) from the drop-down list. If you select Hub, the First Site 
drop-down button becomes available. If you selected Meshed, go to Step 5.

Step 4 For Hub traffic types, select the originating site from the First Site drop-down list.

Step 5 Select a connectivity type from the Connectivity type drop-down list. The choices are Protected, 
Unprotected Minimum Hop, Unprotected Optimum Path, and Unprotected Subnet. Refer to the 
“1.5.3  ROADM Traffic Groups” section on page 1-9 for more information about the connectivity type 
choices. 

Step 6 In the Service types pane, check the boxes for one or more client service types for the ROADM demand. 
The client interfaces that support each service type appear in the right pane.

Step 7 To further refine the client interfaces, complete the following options for each row in the right pane. 
Check boxes in gray are not available for the client interface selection.

 • Yes/No—Check to select this card to implement the service type.

 • Client Interface—Displays the card type for the selected service type.
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 • Y Protected—Check to select Y-cable protection if the connectivity type is Protected.

 • 1+1 Protected—Check to select 1+1 protection if the connectivity type is Protected.

 • Fiber Switched—Check to select fiber-switching protection if the connectivity type is Protected.

 • Supported Service—Displays the service types supported for the card.

You can select more than one client interface to support the same service type. By default, 
Cisco MetroPlanner checks the best client interface to support each service. 

Step 8 Click Ok to save the changes to the demand.

2.6.9  Deleting a Traffic Demand
A traffic demand must be in the Unlocked state before you can delete it. Use the following procedure to 
delete a traffic demand:

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 Verify that the demand is in the Unlocked state. For more information, see the “2.7.4  Unlocking 
Parameters in the Network Design” section on page 2-80.

Step 3 Right-click the demand that you want to delete in the Project Explorer and choose Delete from the 
shortcut menu. As an alternative, you can click Delete in the Tasks Pane.

2.6.10  Editing Fiber Span Parameters
Using the Properties pane, you can manage a fiber span, a fiber pair, and individual fibers. A fiber pair 
consists of two different fibers (clockwise and counter-clockwise). Table 2-24 lists the properties that 
you can modify for a fiber span, pair, or fiber.

Table 2-24 Editable Fiber Properties 

Property Fiber Span Fiber Pair Fiber 

Name Yes Yes No

Ageing loss Yes No No

Ageing factor Yes No No

Fiber type Yes Yes No

Fiber length Yes Yes Yes

Length-based loss Yes Yes Yes

Connector loss (per site) Yes Yes Yes

Absolute loss without connectors Yes Yes No

CD factor Yes Yes No

PMD factor Yes Yes No

Loss Yes Yes Yes
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Use the following procedure to edit fiber span parameters:

Step 1 In the Project Explorer, right-click the Fibers folder and choose Expand from the shortcut menu.

Step 2 In the Project Explorer tree, click one of the following. The options available for editing in the Properties 
pane change depending on your selection.

 • To edit a fiber span, click the duct identifier. 

 • To edit a fiber pair, click the fiber pair identifier. 

 • To edit an individual fiber, click the fiber identifier. 

Step 3 In the Properties pane, edit the following parameters, as necessary. See Table 2-24 for the properties that 
you can change for a fiber span, fiber pair, or individual fiber.

 • Name—Type the desired name for the fiber span, pair, or fiber.

 • Ageing loss—Type the EOL aging loss value. The EOL loss per span value is added at the end of 
life to each discrete fiber in the network (for example, to add an EOL margin for splicing). If you 
set the ageing factor, you do not need to set the ageing loss.

 • Ageing factor—Type the number to factor fiber aging. This factor is multiplied by the SOL total 
span loss without connectors. If you set the ageing loss, you do not need to set the ageing factor.

 • Type—Choose the type of fiber for each span in the network: G652-SMF, E-LEAF, or True Wave.

 • Length—Type the span length. The displayed unit of measure is retrieved from the 
Span Measurements Units field.

 • Length Based Loss—Check to define if the fiber loss is specified as an absolute value or leave 
unchecked if fiber loss is derived from the span length.

 • Connector loss [Site 1]—Type the concentrated connector loss at the end of the span.

 • Connector loss [Site 2]—Type the concentrated connector loss at the end of the span.

 • Abs loss w/o conn [dB]—Type the start of life link fiber loss for each span, without the connector 
concentrated loss. The total SOL loss without connectors is equal to the loss factor multiplied by the 
length. In the Length Based model, this value is calculated automatically.

 • CD—Type the fiber CD factor. The default value is dependent on the selected fiber type. Any value 
that you enter is lost whenever you change the fiber type. Chromatic dispersion is always entered in 
ps/nm/km. Fiber chromatic dispersion is defined for the middle of the wavelength band. C band is 
defined at 1545.3 nm; L band is defined at 1590.4 nm.

 • PMD—Type the PMD factor. The default value is dependent on the selected fiber type. Any value 
that you enter is lost whenever you change the fiber type. PMD is always entered in ps/nm/km. 

 • Loss—Type the value of the SOL fiber loss per kilometer used to calculate the loss of each span in 
the network. The fiber loss factor is always entered in dB/km.

Step 4 As needed, view the following totals for a fiber span, fiber pair, or individual fiber on the Properties pane:

 • Loss BOL—(Display only) Displays the total loss beginning of life (BOL) calculation. 

Note BOL is also referred to as SOL.

 • Loss EOL—(Display only) Displays the total loss EOL calculation.

 • CD—(Display only) Displays the total chromatic dispersion.
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 • PMD—(Display only) Displays the total polarization mode dispersion.

2.6.11  Deleting a Fiber Span
Use the following procedure to delete a fiber span from the network design:

Step 1 In the Project Explorer, right-click the network folder and choose Expand from the shortcut menu.

Step 2 In the Project Explorer, right-click the duct that you want to delete and choose Delete from the shortcut 
menu. As an alternative, you can click Delete in the Tasks Pane.

Step 3 Click Yes to confirm the fiber deletion.

2.6.12  Arranging Sites
Sites can be arranged into four different configurations. Use the following procedure to arrange the sites 
into a configuration or to move all of the sites so that they appear in the Cisco MetroPlanner window:

Step 1 Click the NtView Net# tab.

Step 2 Click the Arrange Sites drop-down list, and choose one of the following:

 • Fit to visible rectangle view—Zooms to display all sites in the NtView Net# tab.

 • Arrange to an ellipse—Rearranges all sites in an ellipse form (Figure 2-41).
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Figure 2-41 Ellipse Shape

 • Arrange to a square—Rearranges all sites in a square form so that the sites appear clockwise around 
the square (Figure 2-42). To complete a full square, this arrangement requires at least four sites.
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Figure 2-42 Square Shape

 • Arrange to a snake—Rearranges all sites so that they cross the NtVw Net# tab from right to left and 
then left to right in a serpentine, linear format (Figure 2-43).
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Figure 2-43 Snake Shape

 • Arrange to a double ring—Rearranges the sites into a dual ring format (Figure 2-44).
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Figure 2-44 Double Ring Shape

2.7  Managing the Network Design
After creating and analyzing a network design, you must prepare the design for installation at a customer 
site. After a network has been installed, you can reanalyze to correct any problems.

Network designs have several possible states:

 • Design—The initial state for any new network design. You can add, delete, or change any aspect of 
the network design. In the Design state, no locks exist. After analyzing a design, you can put it back 
into the Design state to modify it by choosing Design in the Tasks Pane.

 • Design-Analyzed—The state of the network design after you run the network analyzer. All reports 
are available and updated. You cannot change any aspect of the network design. You can modify the 
BoM, such as changing global discounts and spare parts. You can return to the Design state after 
analyzing the network by choosing Design in the Tasks Pane.

 • Copy—A copy of a network. You can create a copy of a network in any state. A copy is useful for 
testing different design options. You can copy a network before or after analyzing it. A copied 
network inherits the set of project options defined in the original network. For more information, 
see the “2.7.1  Creating a Copy of the Network” section on page 2-78.

 • Install—A network is initially designed with theoretical fiber values (such as loss, length, etc.). 
When a network is installed in the field, you can move the network into the Install state so that you 
can enter and check the real fiber parameter values. You can create an Install network from a network 
in the Design-Analyzed or Upgrade-Analyzed state. A network in the Install state inherits the set of 
project options defined in the analyzed network. All sites in an Install network are locked. You 
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cannot modify any aspect of the network design except the span parameters and (on unlocked sites) 
amplifiers. You can, however, modify the BoM. All routed circuits are fixed, and cannot be changed 
while in this state. For more information, see the “2.7.2  Creating a Network in the Install State” 
section on page 2-78.

 • Install-Analyzed—The state of the Install network design after you run the network analyzer. All 
reports are available and updated. Cisco MetroPlanner locks all sites, spans, demands, and 
equipment when a network is in the Install-Analyzed state. 

 • Upgrade—During network design, you define a number of the channels to be implemented at the 
present time and a number of channels to be implemented in the future (forecast). After installing 
the network, you might decide to implement the forecast circuits. To do this, you create an Upgrade 
network and then select the forecast or traffic demand services that you want to implement. You can 
create an Upgrade network from a network in the Design-Analyzed or Install-Analyzed state. You 
can unlock specified parameters to alter the design to include forecasted channels and traffic 
demands. A network in the Upgrade state inherits the set of project options defined in the analyzed 
network. For more information, see the “2.7.3  Creating an Upgrade Network” section on page 2-79.

 • Upgrade-Analyzed—The state of the Upgrade network design after you run the network analyzer. 
All reports are available and updated. Cisco MetroPlanner locks all sites, spans, demands, and 
equipment when a network is in the Upgrade state. 

To complete the procedures in this section, you must have a project open and the network(s) loaded. See 
the “2.1.1  Opening a Project” section on page 2-3 and the “2.1.2  Loading and Unloading Networks” 
section on page 2-3.

2.7.1  Creating a Copy of the Network
To create a copy of a network in any state, right-click the network and choose Copy from the shortcut 
menu. A new copy appears in the Network Mgmt Tree tab.

2.7.2  Creating a Network in the Install State
Use the following procedure to create a network in the Install state:

Step 1 If the network is not analyzed, complete the “2.4  Analyzing the Network” section on page 2-36.

Step 2 Click the Networks Mgmt Tree tab. 

Step 3 Right-click the network and choose Install from the shortcut menu. A new network appears in the 
Networks Mgmt Tree in the Install state. All results from the analyzed network are imported into the 
Install network and are placed in the Locked mode.

Step 4 Make the necessary changes to the Install network. You can edit the following fiber parameters: fiber 
loss value, fiber CD, fiber PMD, and fiber length. See the “2.6.10  Editing Fiber Span Parameters” 
section on page 2-71. Cisco MetroPlanner also allows you to unlock site parameters for modification. 
To change site parameters, see the “2.6.3  Editing Site Parameters” section on page 2-63.

Step 5 In the Networks Mgmt Tree view, click the Analyze Network icon in the toolbar. For more information 
about the Cisco MetroPlanner icons, see Appendix A, “GUI Information and Shortcuts.” The 
MetroPlanner Analyzer status window appears to indicate the progress. As an alternative, click Analyze 
in the Tasks Pane. The Cisco MetroPlanner analysis status bar indicates when the network analysis is 
complete. The network now appears in the Install-Analyzed state.
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Note If you have changed parameters that are inconsistent with the present network layout (for 
example, if you set an output tilt value that the amplifier cannot reach), during network analysis 
an error message on the Analyzer Messages pane identifies which parameter is causing the 
problem.

Step 6 When you have analyzed the network and are satisfied with the results, import the new generated 
installation parameters to each site of the network. For more information, see the “2.5.2  Saving the NE 
Update File” section on page 2-39. 

2.7.3  Creating an Upgrade Network
In an Upgrade network, you can perform the following tasks:

 • Modify the fiber span properties (such as length, dispersion, PMD coefficient, excess losses, and 
aging).

 • Add or delete traffic.

 • Convert forecasted traffic to present traffic.

 • Convert ROADM traffic to present traffic.

 • Modify the type of a node.

 • Force the presence or the absence of a card or a module (this includes amplifiers, OSC modules, 
OADM cards, and DCU modules).

In an Upgrade network, you can force certain installation parameters:

 • Amplifier per-channel output power setpoint

 • Amplifier output tilt setpoint

 • OADM card aggregate output power setpoint

 • Full multiplexer/demultiplexer or ROADM output power setpoint

You cannot change the following parameters when in Upgrade state:

 • Node input channel fail threshold

 • Node OSC channel fail threshold

 • Preamplifier input power threshold

 • OADM card aggregate input power setpoint

 • Full muxponder/demuxponder or ROADM input power setpoint

 • Channels drop power

Use the following procedure to put a network in the Upgrade state:

Step 1 If the network is not analyzed, complete the “2.4  Analyzing the Network” section on page 2-36.

Step 2 Click the Networks Mgmt Tree tab. 

Step 3 Right-click the analyzed network and choose Upgrade from the shortcut menu. A new Upgrade network 
appears in the Networks Mgmt Tree tab. All results from the analyzed network are imported into the 
Upgrade network. 
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Step 4 Make the necessary changes to the Upgrade network. For more information, see the “2.6.10  Editing 
Fiber Span Parameters” section on page 2-71 and the “2.6.3  Editing Site Parameters” section on 
page 2-63.

Step 5 In the Networks Mgmt Tree view, click the Analyze Network icon in the toolbar. For more information 
about the Cisco MetroPlanner icons, see Appendix A, “GUI Information and Shortcuts.” The 
MetroPlanner Analyzer status window appears to indicate the progress. As an alternative, click Analyze 
in the Tasks Pane in any view. The Cisco MetroPlanner analysis status bar indicates when the network 
analysis is complete. The network now appears in the Upgrade-Analyzed state.

Note If you have changed parameters that are inconsistent with the present network layout (for 
example, if you set an output tilt value that the amplifier cannot reach), during network analysis 
an error message on the Analyzer Messages pane identifies which parameter is causing the 
problem.

2.7.4  Unlocking Parameters in the Network Design
The Locked state occurs when you did not set (force) any value for a parameter and instead chose Auto. 
During network analysis, Cisco MetroPlanner assigns a value for each parameter set with Auto and puts 
them in the Locked state. The Locked state indicates that the next time the network is analyzed, the 
analyzer cannot change the value. Locking a site forces the presence or absence of all preamplifiers, 
boosters, add/drop filters, and DCU cards required by the site/network as a result of running the analyzer 
previously. Locked elements are indicated by a closed padlock icon in the Project Explorer 
(Figure 2-45). 

Figure 2-45 Locked Sites in the Project Explorer View

To unlock network components to edit parameters, right-click the desired element in the Project Explorer 
and choose Unlock from the shortcut menu.

2.8  Generating a BoM 
You can generate a BoM when a network is in the Install or Upgrade state, or after you have successfully 
analyzed your network design. The price database selected during project creation is used to generate 
the BoM.

To complete the procedures in this section, you must have a project open and the network(s) loaded. See 
the “2.1.1  Opening a Project” section on page 2-3 and the “2.1.2  Loading and Unloading Networks” 
section on page 2-3.
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2.8.1  Viewing BoM Report Totals
Use the following procedure to view the BoM report totals:

Step 1 Click the Networks Mgmt Tree tab and click the network.

Step 2 In the Tasks Pane, click Bill of Material. The Bill of Material tab appears. 

The upper section of the BoM tab (in the Net view, Site view, and Spare subtabs) displays the following 
information:

 • BoM total discounted—Displays the price for the overall network (without spare parts) for each item 
in the BoM. If Use global discount is checked, the total includes the discount from the Global 
discount percentage field.

 • Spare total discounted—Displays the price for all of the recommended spare parts in all of the 
maintenance centers for the overall network. It is the sum of each spare item using the discounted 
price. The total appears after you check the Spare Part Report check box.

 • BoM + Spare total discounted—Displays the sum of the BoM total discounted price and spare total 
discounted price.

 • Price List—Displays the name of the price list database selected for the project.

 • Price List last update—Displays the date that the selected price list was last updated.

 • Currency—Displays the value of the currency used for each of the price values as specified within 
the selected price list database.

Step 3 To use the Multishelf Management Integrated Kit bundle when generating the BoM instead of the single 
items, check Use bundle. 

Step 4 Check Spare Part Report to include the spare parts in the report totals.

Step 5 The Global discount percentage field shows the percentage from the Global Discount Percentage option 
in the Default Project Options window. To change the global discount for the entire network, check 
Use global discount and enter a new global discount in the form of a percentage in the Global discount 
percentage field. The global discount is applied to all components in the BoM. 

2.8.2  Generating a Network BoM
Use the following procedure to generate a BoM for the network:

Step 1 Click the Networks Mgmt Tree tab and click the network.

Step 2 In the Tasks Pane, click Bill of Material. The Bill of Material tab (Figure 2-46) appears. The Net View 
subtab is selected by default. Items that do not appear in the price list appear in red.
2-81
Cisco MetroPlanner DWDM Operations Guide, Release 7.0

December 2010



 

Chapter 2      Designing Networks with Cisco MetroPlanner
2.8.2  Generating a Network BoM
Figure 2-46 Bill of Material Tab, Net View Subtab

Table 2-25 describes the Net view subtab columns. See the “2.8.1  Viewing BoM Report Totals” section 
on page 2-81 for for a description of the data, check boxes, and fields at the top of the window. 

Table 2-25 BoM Net View Columns 

Column Label Description

Product ID Displays the ID string of the product.

Description Displays a description of the product.

Quantity Displays the number of specific products in the BoM.

Unit price Displays the price for each unit. If the price does not appear, one of the 
following will: 

 • Invalid—Appears when the price list reports “NaN” (Not a Number) for 
the item. This occurs when a price list has never been updated. Invalid 
items appear in the list in orange.

 • Not Found in Price List—Appears when the price list does not contain any 
entry with the PID. These items appear in the list in red. 

Unit Discount Displays the per-unit discount amount that you assigned in the Global Discount 
Percentage field. If you leave the field blank, the discount amount is zero.

Total price Displays the total price of the products before applying the discount.

Discounted Total 
Price

Displays the total price of the products after applying the discount.

Site # Displays the number of products to be assigned to a particular site. The number 
of Site columns is the same as the number of sites in the network.
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Step 3 To close the Bill of Material report, click the X in the upper right corner of the Bill of Material tab.

2.8.3  Generating a Site BoM
A site BoM lists all of the hardware and software parts required for the system to work as designed at a 
given site. Use the following procedure to generate a BoM for a site:

Step 1 Click the NtView Net# tab and click the site.

Step 2 In the Tasks Pane, click Bill of Material. The Site view subtab is selected by default (Figure 2-47). Items 
that do not appear in the price list appear in red.

Figure 2-47 Bill of Material Tab, Site View Subtab

Table 2-26 describes the Site view subtab columns. See the “2.8.1  Viewing BoM Report Totals” section 
on page 2-81 for for a description of the data, check boxes, and fields at the top of the window. 

Table 2-26 BoM Site View Columns 

Column Label Description

Name Displays the name of the item at the site.

PID Displays the ID string of the product.

Quantity Displays the number of that specific item in the BoM.
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Step 3 To close the Bill of Material report, click the X in the upper right corner of the Bill of Material tab.

2.8.4  Generating a Spare Parts Report
After you generate the BoM, use the following procedure to determine the spare parts required by the 
network. If the network is in the Upgrade state, the report includes the parts required to support the 
implemented services and the new additional present services. To generate a spare parts report, you must 
associate a site with a maintenance center before network analysis. For more information, see the 
“2.6.3  Editing Site Parameters” section on page 2-63.

Step 1 Click the Networks Mgmt Tree tab and click the network.

Step 2 In the Tasks Pane, click Bill of Material. Click the Spare subtab (Figure 2-48). 

Unit Price Displays the price per unit. If the price does not display, one of the following 
will: 

 • Invalid—Appears when the price list reports NaN (Not a Number) for the 
item. This occurs when a price list has never been updated. Invalid items 
appear in the list in orange.

 • Not Found in Price List—Appears when the price list does not contain any 
entry with the PID. These items appear in the list in red. 

Unit Discount Displays the per-unit discount amount that you assigned in the Global Discount 
Percentage field. If you leave the field blank, the discount amount is zero.

Total Price Displays the total price of the products before applying the discount.

Discounted Total 
Price

Displays the total price of the products after applying the discount.

Table 2-26 BoM Site View Columns (continued)

Column Label Description
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Figure 2-48 Bill of Material Tab, Spare Subtab

Table 2-27 describes the Spare subtab columns. See the “2.8.1  Viewing BoM Report Totals” section on 
page 2-81 for for a description of the data, check boxes, and fields at the top of the window. 

Table 2-27 BoM Spare Subtab Columns 

Column Label Description

Name Displays the name of the item at the site. Right-click the maintenance center 
and choose Expand All from the shortcut menu to view all spare parts.

PID Displays the ID string of the product.

Quantity Displays the number of specific items in the BoM.

Unit Price Displays the price per unit. If the price does not appear, one of the following 
will: 

 • Invalid—Appears when the price list reports NaN (Not a Number) for the 
item. This occurs when a price list has never been updated. Invalid items 
appear in the list in orange.

 • Not Found in Price List—Appears when the price list does not contain any 
entry with the PID. These items appear in the list in red. 

Unit Discount Displays the per-unit discount amount that you assigned in the Global Discount 
Percentage field. If you leave the field blank, the discount amount is zero.
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Step 3 To close the Bill of Material report, click the X in the upper right corner of the Bill of Material tab.

2.8.5  Exporting a BoM
Use the following procedure to export the BoM to an external file in XML, Excel spreadsheet, HTML, 
or text format:

Step 1 Click the Networks Mgmt Tree tab and click the network.

Step 2 In the Tasks Pane, click Bill of Material. The Bill of Material tab appears. 

Step 3 Click Export. The BoM export dialog box appears.

Step 4 In the BoM export dialog box, type the name of the file, choose the file type (.xml, .xls, .html, or .txt) 
from the drop-down list, and navigate to the desired folder. Click Save.

2.9  Managing the Price List
A price list is defined for each project and is used to generate a BoM. Cisco MetroPlanner can manage 
multiple price lists. You can even change a project price list after a project has been established. The 
Master Price list is the Global Price List in US dollars. You can download new price lists from Cisco 
Connection Online (CCO).

Only the selected price value is saved with a project; the actual price database is not saved with the 
project. When opening a saved project (for example, a project received from another designer), the 
associated price database might not be available. If this is the case, Cisco MetroPlanner notifies you that 
the Master Price list will be used. 

To save memory, Cisco MetroPlanner automatically loads only the price list selected for the current 
project. 

2.9.1  Creating a New Price List
Use the following procedure to download a price list from CCO:

Step 1 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-49).

Total Price Displays the total price of the parts before applying the discount.

Discounted Total 
Price

Displays the total price of the parts after applying the discount.

Table 2-27 BoM Spare Subtab Columns (continued)

Column Label Description
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Figure 2-49 Price Manager Dialog Box

Step 2 In the Price Manager dialog box, right click PriceDBManager and choose New Price DB from the 
shortcut menu.

Step 3 In the Create a New Price DB dialog box, enter the price list name. 

Step 4 From the drop-down list, choose the desired CCO price list. 

Step 5 Click OK.

Step 6 Click OK to update from CCO.

Step 7 In the CCO User Name/Password dialog box, type your user name and password, and click OK. 
Cisco MetroPlanner downloads the CCO price list. 

Step 8 When the update is complete, click OK to close the confirmation dialog box. The new price list appears 
in the PriceDBManager tree. 

Step 9 Click Close to close the Price Manager dialog box.

2.9.2  Viewing a Price List
Use the following procedure to view and filter a price list:

Step 1 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-49 on 
page 2-87). 
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The PriceDB Manager tree lists all of the created price lists. To save memory, Cisco MetroPlanner 
automatically loads only the price list selected for the current project (unless the user requests 
otherwise). An L indicates that the price list is loaded in memory and is available. A U indicates that a 
price list is currently not loaded in memory and is not available. 

Step 2 To load or unload a price list, right-click a price list and choose Load or Unload from the shortcut menu.

Step 3 Click PriceList under the desired price list identifier in the PriceDBManager tree. The list displays in 
the right pane of the Price Manager dialog box. The properties of the price list appear in the bottom left 
corner of the Price Manager dialog box:

 • Label—Identifies the name of the price list.

 • Date update—Indicates the date of the last download from CCO for this price list. If Never appears, 
this indicates that the user created a price list without downloading from CCO.

 • NameCurrency—Identifies the currency used in the price list.

 • Last updated by—Identifies the way in which the price list was updated.

The price list displays the following columns:

 • priceList_ID—For internal use.

 • majorParent_ID—Lists the platform.

 • minorParent_ID—Lists the equipment type.

 • product_ID—Identifies the part number.

 • description—Provides detail about the item.

 • serviceCategory—For internal use.

 • listPrice—Indicates the price of the item. If NaN (Not a Number) appears in the field, the list has 
not been updated.

 • major_ID—For internal use.

 • minor_ID— For internal use.

 • updateStatus—Identifies how the last update was made to an item:

 – Never—Indicates that the price list has never been updated.

 – local_file—Indicates that the price list has been updated from a local file.

 – CCO—Indicates that the price list has been updated from CCO.

 – user—Indicates that the price list has been manually updated by the user who directly edited the 
price list.

 • discount—If a discount applies, identifies the discount percentage. To modify this field, enter the 
new percentage.

Step 4 To search for a specific item in a price list, type the desired item in the Search field at the top of the list. 
As you type, Cisco MetroPlanner filters the list items to match your search entry. To choose Search 
options, click the Search Tool icon to the left of the Search field and choose one of the following:

 • Column name—Searches only the specified column for the search string.

 • Case sensitive—Matches the case of the search string.

 • Case insensitive—Disregards the case of the search string.

 • Match from start—Searches only for the search string if it appears at the beginning of column text.

 • Match any where—Searches for the search string if it appears anywhere in the price list.

Step 5 To sort the items in the price list, double-click on a column to sort by that column. 
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Step 6 Click Close to close the Price Manager dialog box.

2.9.3  Loading and Unloading Price Lists
To save memory, Cisco MetroPlanner automatically loads only the price list selected for the current 
project. An “L” by a price list in the Price Manager dialog box indicates that the price list is loaded; a 
“U” in the Price Manager dialog box indicates that the price list is not loaded. Use the following 
procedure to load or unload price lists in Cisco MetroPlanner:

Step 1 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-49 on 
page 2-87).

Step 2 Right-click the price list and choose Load or Unload from the shortcut menu.

2.9.4  Updating a Price List from CCO
Use the following procedure to update a specified price list from CCO or from a local file. You can also 
update all price lists, even the lists that are not currently loaded.

Step 1 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-49 on 
page 2-87).

Step 2 Right-click the desired price list identifier in the PriceDBManager tree and choose Expand from the 
shortcut menu.

Step 3 Right-click the desired price list in the expanded tree and choose UpdateFromCCO from the shortcut 
menu.

Step 4 In the Update from CCO dialog box, choose Update single price list to download data for the specified 
list or Update all price lists to download the latest data for all price lists.

Step 5 In the CCO User Name/Password dialog box, type your user name and password and click OK. 
Cisco MetroPlanner downloads the price list.

Step 6 When the update is complete, click OK to close the confirmation dialog box. 

Step 7 Click Close to close the Price Manager dialog box.

2.9.5  Copying a Price List
Use the following procedure to create a new price list by copying from an existing one. The new price 
list will have all of the attributes and values of the original price list (such as Updated By, Last Update, 
unit price, discounts, etc.).

Step 1 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-49 on 
page 2-87).
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Step 2 Right-click the desired price list in the PriceDBManager tree and choose Copy from the shortcut menu.

Step 3 Type the name for the new price list and click Ok. The new price list appears in the PriceDBManager 
tree.

Step 4 Click Close to close the Price Manager dialog box.

2.9.6  Deleting a Price List
Use the following procedure to delete a price list. You cannot delete the Master Price List or a price list 
that is in use by a project.

Step 1 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-49 on 
page 2-87).

Step 2 Right-click the desired price list in the PriceDBManager tree and choose Delete from the shortcut menu.

Step 3 Click Close to close the Price Manager dialog box.

2.9.7  Viewing Maintenance Contracts
Use the following procedure to view maintenance contracts:

Step 1 From the Tools menu, choose Price List Mgmt. The Price Manager dialog box appears (Figure 2-49 on 
page 2-87).

Step 2 Right-click Maintenance Contracts and choose Expand from the shortcut menu. 

Step 3 Click ContractsList. The Contract PID column lists the service contract identifiers for the hardware and 
software parts used by Cisco MetroPlanner. The Contract Category column describes the service 
programs. 

Step 4 Click MapPidsContracts. The PID column lists the product identifiers. The Contracts column lists the 
service contract identifier.

Step 5 Click Close to close the Price Manager dialog box.
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C H A P T E R 3

Modeled Network Examples

This chapter provides examples of typical optical networks you can model using Cisco MetroPlanner. 

This chapter contains the following sections:

3.1  Supported Cisco MetroPlanner Topologies, page 3-1

3.2  Bus Topologies, page 3-1

3.3  Hubbed Ring Topology, page 3-2

3.4  Meshed Topology, page 3-3

3.1  Supported Cisco MetroPlanner Topologies
Cisco MetroPlanner supports the following topologies:

 • Bus (single span, point-to-point, and linear)

 • Open (or hubbed) ring

 • Closed (or meshed) ring

An example of each topology is given in this chapter.

3.2  Bus Topologies
Bus topologies comprise three types of topologies: single span, point-to-point, and linear.

3.2.1  Single-Span Topology
Figure 3-1 shows an example of a single-span topology. Single-span topologies are characterized by a 
single span link. The single-span configuration only supports two terminal sites (full terminal or flexible 
channel-count terminal) without any intermediate line amplifier or optical add/drop multiplexing 
(OADM) sites.
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3.2.2  Point-to-Point Topology
Figure 3-1 Single-Span Topology Example

3.2.2  Point-to-Point Topology 
Figure 3-2 shows an example of a point-to-point topology. In a point-to-point topology, all the 
wavelengths are terminated at the same point in the chain. In the point-to-point configuration, no 
channels are added or dropped in intermediate sites.

Figure 3-2 Point-to-Point Topology Example

3.2.3  Linear Topology
Figure 3-3 shows an example of a linear topology. Linear configurations are characterized by the 
presence of two terminal sites (full terminal or flexible channel-count terminal). Between the two 
terminal sites, OADM or line amplifiers nodes can be inserted. In a linear configuration, specific 
wavelengths are terminated at different points in the chain and only unprotected traffic can be 
provisioned.

Figure 3-3 Linear Topology Example

3.3  Hubbed Ring Topology
Figure 3-4 shows an example of a hubbed ring topology. In this configuration, at least one of the sites 
must be a hub site, where all channels are terminated. 
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3.4  Meshed Topology
Figure 3-4 Hubbed Ring Topology Example

3.4  Meshed Topology
Figure 3-5 provides an example of a meshed ring topology. A meshed ring is characterized by the 
absence of a hub node.
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3.4  Meshed Topology
Figure 3-5 Meshed Ring Topology Example
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GUI Information and Shortcuts

This appendix describes the Cisco MetroPlanner views, menus, tools, and shortcuts options. For more 
information about Cisco MetroPlanner, refer to Chapter 1, “Overview.”

Manage the Cisco MetroPlanner Window
The Cisco MetroPlanner window provides a menu bar, toolbar, a Project Explorer pane, a Properties 
pane, an Analyzer pane, and a Task Pane to allow you to manage a network design (Figure A-1). The 
Networks Mgmt Tree tab displays the networks that you have created for a project. The NtVw Net# tab 
displays the sites for a network (identified by the Net# on the tab).

Figure A-1 Cisco MetroPlanner Window with Network Tree

Toolbar

Project
Explorer pane

Properties
pane

Analyzer pane
Status bar

Tasks
Pane
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Menu and Toolbar Options
The Cisco MetroPlanner window menu bar and toolbar provide primary Cisco MetroPlanner functions. 
Table A-1 shows the actions that are available from the menu and toolbar.

Table A-1 Menu and Toolbar Options 

Menu Menu Option Toolbar Description

File New Creates a new Cisco MetroPlanner project. See the “2.3  Creating a Project” 
section on page 2-21.

Open Opens an existing Cisco MetroPlanner project. See the “2.1.1  Opening a 
Project” section on page 2-3.

Close Closes the current project without closing the Cisco MetroPlanner session. If you 
have not saved the current project, Cisco MetroPlanner will prompt you to save 
before closing. See the “2.1.5  Closing a Project” section on page 2-5.

Save Saves the current project. See the “2.1.3  Saving a Project” section on page 2-4.

Save As Allows you to save the current project with a new file name. See the 
“2.1.3  Saving a Project” section on page 2-4.

Clear History — Clears the file history from Cisco MetroPlanner. Cisco MetroPlanner maintains 
a list of the last ten open projects in the File menu. 

Exit — Exits the Cisco MetroPlanner software. 

View My Default 
Layout

— Changes the Cisco MetroPlanner display to the user default layout. 
Cisco MetroPlanner allows you to define the default value for Platform Options, 
Project Options, and General Options. The defined value are used as default for 
each new created project. See the “2.2  Setting Cisco MetroPlanner Options” 
section on page 2-5.

Default Layout — Returns the Cisco MetroPlanner display to the system default layout.

Tasks Pane — Displays the commands available for the selected entity (network, site, duct, 
etc.). 

Project 
Explorer

— Displays the Project Explorer pane, which includes folders for project notes, 
networks, sites, fibers, traffic demand groups, subnets, maintenance centers, 
restricted equipment list, and reports. Clicking the plus (+) sign by each folder 
expands the folder. Clicking the minus (–) sign by each folder hides the folder. 
contents. You can also right-click a folder and choose Expand from the shortcut 
menu to show folder contents. The default location of the Project Explorer pane 
is the upper left section of the Cisco MetroPlanner window.

Properties — Displays the Properties pane, which shows parameter settings for the selected 
entity in the Project Explorer, Networks Mgmt Tree tab, or NtVw Net# tab. The 
default location of the Properties pane is the lower left section of the 
Cisco MetroPlanner window.

Analyzer 
Messages

— Displays the Analyzer Messages pane at the bottom of the Cisco MetroPlanner 
window. The Analyzer Messages pane displays any error messages that occur 
during network analysis.
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Tools Options — Opens the Options Explorer dialog box, where you can change the user default 
settings. See the “2.2  Setting Cisco MetroPlanner Options” section on page 2-5.

DB Parts Mgmt — Opens the PartsTreePanel dialog box, where you can view the list of available 
parts for each release. See the “2.2.4  Setting the Fiber Type Default Values” 
section on page 2-9.

Price List Mgmt — Opens the Price Manager dialog box, where you can view maintenance contracts 
and add price databases. See the “2.9  Managing the Price List” section on 
page 2-86.

Plug In — Opens the PlugIn Registry dialog box, which allows you to customize 
Cisco MetroPlanner with plug-ins released by Cisco. See the “2.2.10  Adding 
Plug-ins” section on page 2-18 and the “2.2.11  Managing Plug-ins” section on 
page 2-19.

Export — Opens the Export dialog box, which allows you to export user options, price lists, 
maintenance contracts, and parts database files. See the “2.2.7  Exporting a File” 
section on page 2-16.

Import — Opens the Import dialog box, which allows you to import user options, price lists, 
maintenance contracts, and parts database files. See the “2.2.8  Importing a File” 
section on page 2-17.

Script Run Script — Opens the Choose a script to run dialog box, which allows you to run a script that 
Cisco provides. See the “2.2.13  Running a Script” section on page 2-21.

Help Manual — Opens the Cisco MetroPlanner online help.

Tips Of The 
Day

— Opens the Tip of the Day dialog box, which provides helpful hints about using 
Cisco MetroPlanner. Click the Next button to view the next tip and the Back 
button to view a previous tip. Check Show Tips on Startup to display the Tip of 
the Day dialog box when you launch Cisco MetroPlanner.

About — Displays Cisco MetroPlanner version information.

— Create a new 
site

Opens the Site Creation wizard when you click this icon and then click in the 
Cisco MetroPlanner window. See the “2.3.1  Adding Sites” section on page 2-27.

— Create a new 
duct

Allows you to create a new duct between sites. See the “2.3.3  Adding Fiber 
Spans” section on page 2-28.

— Create a new 
P2P demand

Opens the Point to Point Demand Creation Wizard when you click this icon and 
then click two sites. See the “2.3.4  Creating a Point-to-Point Demand” section 
on page 2-29.

— Create a new 
P-ring demand

Opens the P-Ring Creation Wizard. See the “2.3.5  Creating a Protected Ring 
Demand” section on page 2-31.

— Zoom in Zooms in on the NtVw Net# tab. 

Table A-1 Menu and Toolbar Options (continued)

Menu Menu Option Toolbar Description
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Cisco MetroPlanner Panes
Cisco MetroPlanner provides four panes that help you manage a network design: Project Explorer, 
Properties, Analysis, and Tasks Pane.

— Zoom out Zoom out from the NtVw Net# tab.

— Normal viewing Returns the NtVw Net# tab to normal viewing (1:1).

— Fit to window Resizes the view so that all sites fit inside the NtVw Net# tab window.

— Analyze 
Network

Analyzes the selected network. See the “2.4  Analyzing the Network” section on 
page 2-36.

— Enter design 
mode

Puts the selected Design-Analyzed network back into the design mode for further 
changes. See the “2.4  Analyzing the Network” section on page 2-36.

— Put current 
network in 
upgrade mode

Creates a copy of the selected Design-Analyzed network in the Upgrade state. 
See the “2.7.3  Creating an Upgrade Network” section on page 2-79.

— Delete current 
network

Deletes the selected network. See the “2.3.7  Deleting a Network” section on 
page 2-35.

— Copy current 
network

Copies the selected network. See the “2.7.1  Creating a Copy of the Network” 
section on page 2-78.

— Put current 
network in 
install mode

Creates a copy of the selected Design-Analyzed network in the Install state. See 
the “2.7.2  Creating a Network in the Install State” section on page 2-78.

— Reports Diff Opens the Reports Diff dialog box, which allows you to create a report that shows 
the differences between networks. 

— Run the 
Garbage 
Collector

Deletes unloaded networks from memory. 

Table A-1 Menu and Toolbar Options (continued)

Menu Menu Option Toolbar Description
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Project Explorer Pane

The Project Explorer pane provides a management tree for the entire project. Each network appears as a 
folder that contains the sites, fibers, traffic groups, subnets, maintenance centers, restricted equipment 
lists, and reports for that network. If you have made changes to a network design, that network folder 
and the changed item folder appear in blue italics in the pane. 

By default, the Project Explorer pane is located in the upper left section of the Cisco MetroPlanner 
window. Table A-2 shows the actions that are available from the Project Explorer toolbar.

Properties Pane

The Properties pane shows all of the parameters set for a selected item (either in the Project Explorer, 
the Network Mgmt Tree tab, or the NtVw Net# tab). Many items are editable in the Properties pane. By 
default, the Properties pane is located in the lower left section of the Cisco MetroPlanner window.

Table A-2 Project Explorer Toolbar Options 

Toolbar Description

Displays the Project Explorer as a single pane.

Displays the Project Explorer as split panes. The upper pane contains the main project tree; 
the lower pane shows only the folders for the network that is selected in the upper pane.

Auto scrolls to the selected object in the Project Explorer tree. For example, if you click 
on a site in the NtView Net# tab but it is not in view in the Project Explorer tree, 
Cisco MetroPlanner will automatically scroll the Project Explorer pane until the selected 
site is in view.

Moves backward through the list of previously selected items in the Project Explorer.

Moves forward through the list of previously selected items in the Project Explorer.

Moves (undocks) the Project Explorer pane from the default location in the upper left 
corner so that you can move it around your desktop area as an individual window. 

Moves the Project Explorer back to the default location.

Hides the Project Explorer. To view again, move the mouse over the Prop tab that appears 
in the upper left corner of the Cisco MetroPlanner window. 

When in hidden mode, reopens the Project Explorer in the default location.

Closes the Project Explorer pane. To reopen, choose Project Explorer from the View 
menu.
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Table A-3 shows the actions that are available from the Properties Pane toolbar.

Analyzer Pane

The Analyzer tab at the bottom of the Cisco MetroPlanner window appears after you have analyzed a 
network design. Clicking the Analyzer tab opens the Analyzer pane. Table A-5 shows the actions that 
are available from the Analyzer pane.

Table A-3 Properties Pane Toolbar Options 

Toolbar Description

Categorizes the properties by type. 

Organizes the properties in alphabetical order. 

Shows or hides the description area at the bottom of the Properties pane.

Expands the property categories (if collapsed).

Collapses the property categories (if expanded).

Moves (undocks) the Properties pane from the default location in the lower left corner so 
that you can move it around your desktop area as an individual window. 

Moves the Properties pane back to the default location.

Hides the Property pane. To view again, move the mouse over the Prop tab that appears in 
the upper left corner of the Cisco MetroPlanner window. 

When in hidden mode, reopens the Properties pane so that it appears in the default location.

Closes the Properties Pane. To reopen, choose Properties from the View menu.
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Tasks Pane

The Tasks Pane lists the available commands and reports for a selected item. The commands change 
based on the selected item. For example, a selected site will have different commands available than a 
selected fiber span. By default, the Tasks Pane is located in the upper right section of the 
Cisco MetroPlanner window. Table A-5 shows the actions that are available from the Tasks Pane toolbar.

Table A-4 Analyzer Toolbar Options 

Toolbar Description

Moves down through the Analyzer messages.

Moves up through the Analyzer messages.

Opens the Apply Filters dialog box, which allows you to filter the messages to show or hide 
Exceptions, Errors, Warnings, and/or Info.

Expands the Analyzer message categories (if collapsed).

Collapses the Analyzer message categories (if expanded).

Moves (undocks) the Analyzer pane from the default location in the lower left corner so 
that you can move it around your desktop area as an individual window. 

Moves the Analyzer pane back to the default location.

Hides the Analyzer pane. To view again, move the mouse over the Analyzer tab that appears 
in the bottom of the Cisco MetroPlanner window.

Opens the Analyzer pane so that it remains open in the bottom section of the 
Cisco MetroPlanner window.

Closes the Analyzer pane. To reopen, choose Analyzer messages from the View menu.

Table A-5 Tasks Pane Toolbar Options 

Toolbar Description

Moves (undocks) the Tasks Pane from the default location in the lower left corner so that 
you can move it around your desktop area as an individual window. 

Moves the Tasks Pane back to the default location.
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Shortcuts
Cisco MetroPlanner provides the following mouse shortcuts:

 • Double-clicking a network icon in the Network Mgmt Tree tab opens the NtVw Net# tab, which 
shows the sites for that network. 

 • Right-clicking a report table column displays a shortcut menu that allows you to view or hide the 
columns in a report. 

 • Right-clicking an item in the Network Mgmt Tree tab or NtVw Net# tabs opens a shortcut menu that 
allows you to choose actions to perform on the selected item. The shortcut menu options differ based 
on the item selected and the network state. (Many commands are not available until a network is 
analyzed.) Table A-6 lists the shortcut menu actions that are available for each item.

Hides the Tasks Pane. To view again, move the mouse over the Tasks tab that appears in 
the upper right corner of the Cisco MetroPlanner window. 

When in hidden mode, reopens the Tasks Pane so that it appears in the default location.

Closes the Tasks Pane. To reopen, choose Tasks Pane from the View menu.

Table A-5 Tasks Pane Toolbar Options (continued)

Toolbar Description
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Table A-6 Shortcut Menu Actions 

Item Available Shortcut Actions

Networks in the 
following states: 
Design, Install, and 
Upgrade 

 • Unload/Load—Unloads or loads the network. See the “2.1.2  Loading and 
Unloading Networks” section on page 2-3.

 • Edit Note—Allows you to create a note for the network. See the 
“2.3.8  Adding Notes to a Project” section on page 2-35.

 • Delete—Removes the network from the project. See the “2.3.7  Deleting a 
Network” section on page 2-35.

 • Copy—Creates a copy of the network. See the “2.7.1  Creating a Copy of 
the Network” section on page 2-78.

 • Arrange Sites—Allows you to rearrange sites in the Cisco MetroPlanner 
window. See the “2.6.12  Arranging Sites” section on page 2-73.

Analyzed networks  • Unload/Load—Unloads or loads the network. See the “2.1.2  Loading and 
Unloading Networks” section on page 2-3.

 • Edit Note—Allows you to create a note for that item. See the 
“2.3.8  Adding Notes to a Project” section on page 2-35.

 • Install—Creates a copy of the network in the Install state. See the 
“2.7.2  Creating a Network in the Install State” section on page 2-78.

 • Delete—Removes the network from the project. See the “2.3.7  Deleting a 
Network” section on page 2-35.

 • Upgrade—Creates a copy of the network in the Upgrade state. See the 
“2.7.3  Creating an Upgrade Network” section on page 2-79.

 • Copy—Creates a copy of the network. See the “2.7.1  Creating a Copy of 
the Network” section on page 2-78.

 • Layout—Opens the Layout tab. See the “2.5.6  Displaying the Layout” 
section on page 2-46.

 • Internal Connections—Opens the Internal Connections tab. See the 
“2.5.4  Viewing Internal Connections” section on page 2-42.

 • Optical Results—Opens the Optical Results tab. See the “2.5.8  Viewing 
Optical Results” section on page 2-51.

 • Wavelength Routing—Opens the Wavelength Routing tab. See the 
“2.5.9  Viewing Wavelength Routing” section on page 2-54.

 • Bill of Material—Opens the Bill of Materials tab. See the 
“2.8.2  Generating a Network BoM” section on page 2-81.

 • Installation—Opens a submenu with the following options: 

 – NE Update—Creates a configuration file for each site in the network 
See the “2.5.2  Saving the NE Update File” section on page 2-39.

 – Installation Parameters—Opens the Installation Parameters tab. See 
the “2.5.3  Viewing the Installation Parameters” section on page 2-40.

 • Arrange Sites—Allows you to rearrange sites in the Cisco MetroPlanner 
window. See the “2.6.12  Arranging Sites” section on page 2-73.
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Site Icons
A site icon indicates the functionality of site. Table A-7 lists the site icons.

Sites  • Edit Note—Allows you to create a note for that item. See the 
“2.3.8  Adding Notes to a Project” section on page 2-35.

 • Delete—Removes the site from the project. See the “2.6.4  Deleting a 
Site” section on page 2-67.

If the network is analyzed, the following actions are also available:

 • Layout—Opens the Layout tab. See the “2.5.6  Displaying the Layout” 
section on page 2-46.

 • Internal Connections—Opens the Internal Connections tab. See the 
“2.5.4  Viewing Internal Connections” section on page 2-42.

 • Optical Results—Opens the Optical Results tab. See the “2.5.8  Viewing 
Optical Results” section on page 2-51.

 • Wavelength Routing—Opens the Wavelength Routing tab. See the 
“2.5.9  Viewing Wavelength Routing” section on page 2-54.

 • Bill of Material—Opens the Bill of Materials tab. See the 
“2.8.2  Generating a Network BoM” section on page 2-81.

 • Installation—Opens a submenu with the following options: 

 – NE Update—Creates a configuration file for each site in the network. 
See the “2.5.2  Saving the NE Update File” section on page 2-39.

 – Installation Parameters—Opens the Installation Parameters tab. See 
the “2.5.3  Viewing the Installation Parameters” section on page 2-40.

 • Unlock—Unlocks the site. See the “2.7.4  Unlocking Parameters in the 
Network Design” section on page 2-80.

Fiber spans  • Edit Note—Allows you to create a note for that item. See the 
“2.3.8  Adding Notes to a Project” section on page 2-35.

If the network is analyzed, the Unlock command is also available. See the 
“2.7.4  Unlocking Parameters in the Network Design” section on page 2-80.

Traffic demands  • Edit Note—Allows you to create a note for that item. See the 
“2.3.8  Adding Notes to a Project” section on page 2-35.

 • Edit—Allows you to edit the demand. See the “2.6.6  Editing a 
Point-to-Point Demand” section on page 2-67, “2.6.7  Editing a P-Ring 
Demand” section on page 2-68, or “2.6.8  Editing a ROADM Demand” 
section on page 2-70.

 • Delete—Removes the demand from the project. See the “2.6.9  Deleting a 
Traffic Demand” section on page 2-71.

If the network is analyzed, the Unlock command is also available. See the 
“2.7.4  Unlocking Parameters in the Network Design” section on page 2-80.

Table A-6 Shortcut Menu Actions (continued)

Item Available Shortcut Actions
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Table A-7 Site Icons

Site Name Site Icon Description

Add/Drop Indicates that this site has add/drop capability. 
Only point-to-point and P-ring circuits can be 
added/dropped at this site.

Gain equalizer Indicates that this site uses WSS cards to control 
the generated tilt and extend unregenerated 
distances. The site is realized as an ROADM site 
without demultiplexer cards.

Hub Indicates that this site is equipped with filters for 
adding and dropping all the channels (on both 
West and East sides). All express paths are open 
in hub configurations.

Line amplifier Indicates that any add/drop traffic is prevented at 
this site.

OSC site Indicates that site is designated for network 
communication, providing the possibility to 
access the optical service channel (OSC) for 
management of the MSTP network. By default, no 
amplifiers are included in this site. However, if 
Cisco MetroPlanner determines that an amplifier 
is required in the network, it can automatically 
place it at this location. Cisco MetroPlanner 
allows you to set (force) preamplifier and booster 
amplifiers for each direction on a OSC Site node.

Pass Through Indicates that no equipment will be located at this 
site.

R-OADM Indicates that this site supports Any-to-Any and 
also Fixed (point-to-point and P-ring) traffic 
types.
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Card Types

This appendix provides a list of interface and card types supported in Cisco MetroPlanner, as well as the 
corresponding Cisco product ID (Tables B-1 to B-29). 

Table B-1 OC-192/STM-64 (9.953 Gbps) 

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L with 
EFEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L with FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L without 
FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E with EFEC Client 1+1

Y-Cable

15454-10E-L1-xx.y= (C band)

15454-10E-L1-xx.y= (L band)

Transponder TXP_MR_10E with FEC Client 1+1

Y-Cable

15454-10E-L1-xx.y= (C band)

15454-10E-L1-xx.y= (L band)

Transponder TXP_MR_10E without 
FEC

Client 1+1

Y-Cable

15454-10E-L1-xx.y= (C band)

15454-10E-L1-xx.y= (L band)

Transponder TXP_MR_10G with FEC Client 1+1

Y-Cable

15454-10T-L1-xx.y=

Transponder TXP_MR_10G without 
FEC

Client 1+1

Y-Cable

15454-10T-L1-xx.y=

LineCard OC-192 LR

STM-64 LR

Client 1+1 15454-192L-1-xx.y= (ANSI)

15454E-64L-xx.y= (ETSI)
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Table B-2 OC-48/STM-16  (2.488 Gbps) 

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G

TXPP_MR_2.5G with FEC

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G without 
FEC

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder MXP_2.5_10E_C and 
MXP_2.5_10E_L with 
EFEC

Client 1+1

Y-Cable

15454-10ME-L1-C= (C band)

15454-10ME-L1-L= (L band)

Transponder MXP_2.5_10E_C and 
MXP_2.5_10E_L with FEC

Client 1+1

Y-Cable

15454-10ME-L1-C= (C band)

15454-10ME-L1-L= (L band)

Transponder MXP_2.5_10E with EFEC Client 1+1

Y-Cable

15454-10ME-xx.y=

Transponder MXP_2.5_10ET with FEC Client 1+1

Y-Cable

15454-10ME-xx.y=

Transponder MXP_2.5_10G with FEC Client 1+1

Y-Cable

15454-10M-L1-xx.y=

Transponder MXP_2.5_10G without 
FEC

Client 1+1

Y-Cable

15454-10M-L1-xx.y=

LineCard OC48ELR / SMT-16ELR Client 1+1 15454-O48E-1-xx.y (ANSI)

15454E-EL16HSxxyy= (ETSI)

Table B-3 OC-12/STM-4  (622 Mbps) 

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G

TXPP_MR_2.5G with FEC

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G without 
FEC

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)
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Table B-4 OC-3/STM-1  (155 Mbps) 

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G

TXPP_MR_2.5G with FEC

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G without 
FEC

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-5 10GE WAN PHY (9.953 Gbps) 

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L with 
EFEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L with FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L without 
FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E with EFEC Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E with FEC Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E without 
FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10G with FEC Client 1+1

Y-Cable

15454-10T-L1-xx.y=

Transponder TXP_MR_10G without 
FEC

Client 1+1

Y-Cable

15454-10T-L1-xx.y=

Table B-6 10GE LAN PHY (10.3 Gbps) 

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L with 
EFEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L with FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)
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Transponder TXP_MR_10E_C and 
TXP_MR_10E_L without 
FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E with EFEC Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E with FEC Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E without 
FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10G with FEC Client 1+1

Y-Cable

15454-10T-L1-xx.y=

Transponder TXP_MR_10G without 
FEC

Client 1+1

Y-Cable

15454-10T-L1-xx.y=

Table B-7 GE (1.25Gbps) 

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_2.5G

MXPP_MR_2.5G

Client 1+1

Y-Cable

Fiber-Switched

15454-DM-L1-xx.y= (Unprot)

15454-DMP-L1-xx.y= (Prot)

Transponder MXP_MR_10DME with 
EFEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1

Y-Cable 

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G with FEC

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G without 
FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Pluggable GE DWDM GBIC Client 1+1 15454-GBIC-xx.y=

Table B-6 10GE LAN PHY (10.3 Gbps) (continued)

Interface Type Card Type Protection Type Product ID
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Table B-8 Fast Ethernet (100 Mbps) 

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 

TXPP_MR_2.5G 2R

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-9 FC-10G (10.5 Gbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L with 
EFEC 

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L with FEC

Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E_C and 
TXP_MR_10E_L without 
FEC

Client 1+1 

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E with EFEC Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E with FEC Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Transponder TXP_MR_10E without FEC Client 1+1

Y-Cable

15454-10E-L1-C= (C band)

15454-10E-L1-L= (L band)

Table B-10 FC-4G (4.25 Gbps) 

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_10DME with 
EFEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1 

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)
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Table B-11 FC-2G (2.125 Gbps) 

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_2.5G

MXPP_MR_2.5G

Client 1+1

Y-Cable 

Fiber-Switched

15454-DM-L1-xx.y= (Unprot)

15454-DMP-L1-xx.y= (Prot)

Transponder MXP_MR_10DME with 
EFEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1 

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder TXP_MR_2.5G 

TXPP_MR_2.5G with FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G 

TXPP_MR_2.5G without 
FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-12 FC-1G (1.062 Gbps) 

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_2.5G

MXPP_MR_2.5G

Client 1+1 

Y-Cable 

Fiber-Switched

15454-DM-L1-xx.y= (Unprot)

15454-DMP-L1-xx.y= (Prot)

Transponder MXP_MR_10DME with 
EFEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1

 Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G with FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G 

TXPP_MR_2.5G without 
FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)
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Table B-13 FICON-2G (2.125 Gbps) 

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_2.5G

MXPP_MR_2.5G

Client 1+1 

Y-Cable 

Fiber-Switched

15454-DM-L1-xx.y= (Unprot)

15454-DMP-L1-xx.y= (Prot)

Transponder MXP_MR_10DME with 
EFEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1 

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G with FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G 

TXPP_MR_2.5G without 
FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-14 FICON-1G (1.062 Gbps) 

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_2.5G

MXPP_MR_2.5G

Client 1+1 

Y-Cable 

Fiber-Switched

15454-DM-L1-xx.y= (Unprot)

15454-DMP-L1-xx.y= (Prot)

Transponder MXP_MR_10DME with 
EFEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1

 Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G with FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G without 
FEC

Client 1+1

Y-Cable 

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)
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Table B-15 ESCON (200 Mbps) 

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_2.5G

MXPP_MR_2.5G

Client 1+1 

Y-Cable 

Fiber-Switched

15454-DM-L1-xx.y= (Unprot)

15454-DMP-L1-xx.y= (Prot)

Transponder TXP_MR_2.5G

TXPP_MR_2.5G 2R

Client 1+1

Y-Cable

 Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-16 ISC-Compat (1.062 Gbps) 

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G without FEC Client 1+1 15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Transponder MXP_MR_10DME with 
EFEC

Client 1+1 15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1 15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1 15454-10DME-C= (C band)

15454-10DME-L= (L band)

Table B-17 ISC-Peer 2R 

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 2R Client 1+1 15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-18 ISC-3 Peer-1G  (1.062 Gbps) 

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_10DME with 
EFEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1 

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)
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Table B-19 ISC-3 Peer-2G (2.125 Gbps) 

Interface Type Card Type Protection Type Product ID

Transponder MXP_MR_10DME with 
EFEC

Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME with FEC Client 1+1

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Transponder MXP_MR_10DME without 
FEC

Client 1+1 

Y-Cable

15454-10DME-C= (C band)

15454-10DME-L= (L band)

Table B-20 Sysplex ETR  (8 Mbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 2R Client 1+1 15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-21 Sysplex CLO  (8 Mbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 2R Client 1+1 15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-22 SDI

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 

TXPP_MR_2.5G 2R

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-23 DVB-ASI

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 
TXPP_MR_2.5G 2R

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)
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Table B-24 D1-Video  (270 Mbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 
TXPP_MR_2.5G 2R

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-25 HDTV  (1.48 Gbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 
TXPP_MR_2.5G 2R

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-26 DV-6000  (2.38 Gbps)

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 
TXPP_MR_2.5G 2R

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-27 2R Any Rate

Interface Type Card Type Protection Type Product ID

Transponder TXP_MR_2.5G 
TXPP_MR_2.5G 2R

Client 1+1

Y-Cable

Fiber-Switched

15454-MR-L1-xx.y= (Unprot)

15454-MRP-L1-xx.y= (Prot)

Table B-28 ONS 15530 2.5G ITU-T

Interface Type Card Type Protection Type Product ID

TXP MR MM TXP

MR SM TXP

MR MM TXP with splitter

MR SM TXP with splitter

Client 1+1

Fiber-Switched

15530-TSP1-xx21 (MM Unprot)

15530-TSP1-xx22 (SM Unprot)

15530-TSP1-xx11 (MM Prot)

15530-TSP1-xx12 (SM Prot)

LC 2.5-Gbps Aggregation

2.5-Gbps Aggregation with 
splitter

Client 1+1

Fiber-Switched

15530-ITU3-xx20 (Unprot)

15530-ITU3-xx10 (Prot)
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Table B-29 ONS 15530 10G ITU-T

Interface Type Card Type Protection Type Product ID

LC 10-Gbps Aggregation

10-Gbps Aggregation with 
splitter

Client 1+1

Fiber-Switched

15530-ITU2-xx20 (Unprot)

15530-ITU2-xx10 (Prot)

MXP Data Muxponder 

Data Muxponder with splitter

Client 1+1

Fiber-Switched

15530-MSMP-xx22 (Unprot)

15530-MSMP-xx12 (Prot)
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